
Pentaho User Console Guide



This document supports Pentaho Business Analytics Suite 4.8 GA and Pentaho Data Integration 4.4 GA,
documentation revision October 31, 2012.

This document is copyright © 2012 Pentaho Corporation. No part may be reprinted without written permission from
Pentaho Corporation. All trademarks are the property of their respective owners.

Help and Support Resources
If you have questions that are not covered in this guide, or if you would like to report errors in the documentation,
please contact your Pentaho technical support representative.

Support-related questions should be submitted through the Pentaho Customer Support Portal at
http://support.pentaho.com.

For information about how to purchase support or enable an additional named support contact, please contact your
sales representative, or send an email to sales@pentaho.com.

For information about instructor-led training on the topics covered in this guide, visit
http://www.pentaho.com/training.

Limits of Liability and Disclaimer of Warranty
The author(s) of this document have used their best efforts in preparing the content and the programs contained
in it. These efforts include the development, research, and testing of the theories and programs to determine their
effectiveness. The author and publisher make no warranty of any kind, express or implied, with regard to these
programs or the documentation contained in this book.

The author(s) and Pentaho shall not be liable in the event of incidental or consequential damages in connection
with, or arising out of, the furnishing, performance, or use of the programs, associated instructions, and/or claims.

Trademarks
Pentaho (TM) and the Pentaho logo are registered trademarks of Pentaho Corporation. All other trademarks are the
property of their respective owners. Trademarked names may appear throughout this document. Rather than list
the names and entities that own the trademarks or insert a trademark symbol with each mention of the trademarked
name, Pentaho states that it is using the names for editorial purposes only and to the benefit of the trademark
owner, with no intention of infringing upon that trademark.

Company Information
Pentaho Corporation
Citadel International, Suite 340
5950 Hazeltine National Drive
Orlando, FL 32822
Phone: +1 407 812-OPEN (6736)
Fax: +1 407 517-4575
http://www.pentaho.com

E-mail:  communityconnection@pentaho.com

Sales Inquiries:  sales@pentaho.com

Documentation Suggestions:  documentation@pentaho.com

Sign-up for our newsletter:  http://community.pentaho.com/newsletter/

http://support.pentaho.com
mailto:sales@pentaho.com
http://www.pentaho.com/training
http://www.pentaho.com
mailto:communityconnection@pentaho.com
mailto:sales@pentaho.com
mailto:documentation@pentaho.com
http://community.pentaho.com/newsletter/


 | TOC | 3

Contents

Introduction................................................................................................................................6
Pentaho User Console Basics...................................................................................................7

Logging into the Pentaho User Console....................................................................................................... 7
Navigating the Pentaho User Console..........................................................................................................7

Creating a New Solution Folder......................................................................................................... 8
Deleting a Solution Folder..................................................................................................................9
Using My Workspace......................................................................................................................... 9
Creating Reports..............................................................................................................................10
Role and User Based Access.......................................................................................................... 10

Using Pentaho Interactive Reporting.......................................................................................11
Selecting a Data Source............................................................................................................................. 11
Creating a New Interactive Report..............................................................................................................11
Saving Interactive Reports..........................................................................................................................12
Filtering Reports......................................................................................................................................... 12

Adding a Filter..................................................................................................................................12
Creating Advanced Filters................................................................................................................13
Applying a Summary Function......................................................................................................... 13
Applying an Aggregate Function......................................................................................................13
Flagging a Filter Constraint for Use as a Dashboard Parameter..................................................... 14
Adding a Filter on Date Fields..........................................................................................................14

Disabling Auto Refresh Mode in Interactive Reports.................................................................................. 15
Enabling Row Limit and Query Timeout..................................................................................................... 15
Refining Your Report.................................................................................................................................. 15

Editing Report Headers and Footers............................................................................................... 15
Editing the Report Title.................................................................................................................... 15
Reordering and Adjusting Columns................................................................................................. 15

Formatting Reports..................................................................................................................................... 16
Changing the Report Template........................................................................................................16
Changing Page Format and Orientation.......................................................................................... 16
Changing a Column Header Name..................................................................................................16
Applying Copy/Paste Formatting..................................................................................................... 16
Changing the Format of Numeric Values.........................................................................................16

Editing Interactive Reports..........................................................................................................................16
Interactive Reports and Report Designer................................................................................................... 17
Examining an Interactive Report in View-Only Mode................................................................................. 17
Interactive Reporting Quick Reference.......................................................................................................18

Using Pentaho Analyzer.......................................................................................................... 22
Creating a New Analyzer Report................................................................................................................ 22

Adding Filters to an Analyzer Report............................................................................................... 25
Adding Query Parameters to Analyzer Reports...............................................................................26
Exporting an Analyzer Report.......................................................................................................... 26
Filtering by Member Properties........................................................................................................26
Configuring Drill-Down Links............................................................................................................27
Disabling Auto Refresh Mode.......................................................................................................... 27
Creating Hyperlinks to Pentaho Solution Repository Content......................................................... 27
Creating Hyperlinks to a URL.......................................................................................................... 29
Simple Conditional Formatting of Measures.................................................................................... 30

Analyzer Visualizations...............................................................................................................................30
Setting Chart Options.......................................................................................................................30
Displaying Multi-Charts in Analyzer................................................................................................. 31
Geography Map Visualizations In Analyzer..................................................................................... 31
Scatter Chart Visualizations In Analyzer..........................................................................................33
Heat Grid Visualizations In Analyzer................................................................................................34
Creating a New Analysis View......................................................................................................... 36

Using Pentaho Dashboard Designer....................................................................................... 37



 | TOC | 4

Creating a New Dashboard........................................................................................................................ 37
Working with the Chart Designer..................................................................................................... 37
Adding Data to a Chart.................................................................................................................... 38
Working with Pie Charts...................................................................................................................41
Working with Dial Charts..................................................................................................................42
Correcting Scaling Issues................................................................................................................ 43
Rotating Chart Axis Labels.............................................................................................................. 43
Editing a Chart................................................................................................................................. 43
Adding a Data Table to a Dashboard...............................................................................................43
Updating the Data Table Display..................................................................................................... 44
Adding a Report Designer Report to a Dashboard.......................................................................... 45
Adding an Action Sequence to a Dashboard................................................................................... 46
Adding an Analyzer Report to a Dashboard.................................................................................... 47
Adding a Web Site to a Dashboard..................................................................................................47

Implementing Filters................................................................................................................................... 47
Creating a Static List of Options...................................................................................................... 48
Creating a SQL List..........................................................................................................................50
Creating a Metadata List..................................................................................................................51
Creating a Cascading Filter............................................................................................................. 53
Editing Filters................................................................................................................................... 56
Linking Dashboard Filters to Analyzer Parameters..........................................................................56

Dashboard Parameters...............................................................................................................................58
Creating Chart or Data Table Parameters With the Query Editor....................................................59
Dynamic Dashboard Titles...............................................................................................................59

Using Content Linking to Create Interactive Dashboards...........................................................................60
Linking Charts and Data Tables.......................................................................................................61
Linking Columns in a Data Table to Content in other Dashboard Panels........................................62
Creating Content to Content Links in an Analyzer Report............................................................... 64
Linking an Analyzer Chart to a Report............................................................................................. 66
Linking an Action Sequence Parameter to Content in other Dashboard Panels............................. 68
Controlling a Dashboard Parameter From a PRPT Hyperlink......................................................... 69

Adding Content to a Dashboard Using Drag-and-Drop.............................................................................. 71
Adjusting Whitespace in Dashboard Panels...............................................................................................71
Printing Dashboards................................................................................................................................... 72
Printing a Dashboard Panel........................................................................................................................72
Setting the Refresh Interval........................................................................................................................ 73

Using Pentaho Mobile..............................................................................................................74
Setting Up Mobile Access...........................................................................................................................74
Getting Started with Pentaho Mobile.......................................................................................................... 74

Creating a Shortcut Using Safari..................................................................................................... 74
Working with the Home Screen....................................................................................................... 74
Navigating Files............................................................................................................................... 76
Creating and Removing Favorites................................................................................................... 76
Settings............................................................................................................................................ 76

Working with Pentaho Mobile Tools........................................................................................................... 77
Using the Overlay Toolbar............................................................................................................... 77
Mobile Reports.................................................................................................................................77
Mobile Analyzer............................................................................................................................... 78
Mobile Dashboards.......................................................................................................................... 78

Administration and Advanced User Topics..............................................................................80
Customizing the Pentaho User Console.....................................................................................................80
Adding a Data Source in the Pentaho User Console..................................................................................80

Connecting to Your Database..........................................................................................................81
Creating a SQL Query Data Source in the Pentaho User Console................................................. 82
Creating a CSV Data Source in the Pentaho User Console............................................................ 83
Creating Database Table(s) Data Sources...................................................................................... 86
Creating a Database Table Data Source (Reporting Only)..............................................................86
Creating a Database Table Data Source (Reporting and Analysis).................................................87
Using the Modeler to Customize a Data Source..............................................................................88
Editing a Database Connection in the Pentaho User Console........................................................ 91



 | TOC | 5

Deleting a Database Connection in the Pentaho User Console...................................................... 91
Deleting a Data Source in the Pentaho User Console.....................................................................91
Adding Member Properties.............................................................................................................. 91
Auto Modeling Geography Dimension............................................................................................. 92

Scheduling Reports.................................................................................................................................... 92
Scheduling a Report........................................................................................................................ 92
Deactivating Schedules................................................................................................................... 93
Refreshing the Reporting Data Cache............................................................................................. 93

Pentaho Interactive Report Settings........................................................................................................... 94
Troubleshooting..........................................................................................................................................94
Dashboard Printing Not Working Consistently............................................................................................95



 | Introduction | 6

Introduction

The Pentaho BA Server is a Web-based framework that leverages elements of Pentaho Analysis and Pentaho
Reporting to provide easy-to-use tools for creating and sharing reports and dashboards.

The BA Server Enterprise Edition includes two graphical user interfaces:

The Pentaho User Console, which includes

• Interactive Reporting for quick and easy data-driven reports
• Pentaho Analyzer for ROLAP-based reports and charts
• Pentaho Dashboard Designer for informative overviews of key performance indicators

and the Pentaho Enterprise Console which gives system administrators, IT managers, CIOs, and database
administrators fine-grained control over most aspects of BA Server configuration, management, and security.

The purpose of this guide is to teach business users how to use the Pentaho User Console. The instructions herein
assume that the BA Server has been properly configured for users, roles, and data sources through the Pentaho
Enterprise Console. If you need help configuring the BA Server, refer to the Pentaho Business Analytics Administrator's
Guide.
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Pentaho User Console Basics

Ensure that you have the Web address and login credentials for the Pentaho User Console. If you do not have them
you must contact your system administrator, IT manager, or supervisor.

How to Log Into the Pentaho User Console
Follow these steps to log into the Pentaho User Console:

1. Open a Web browser and type in the address of the Pentaho server.

You'll see an introductory screen with a Login button in the middle.

2. Click Login.

A login-related pop-up appears.

3. Type your user name and password in the appropriate fields and click Login.

Note:  If you or your BI administrator did not set up user accounts in the BA Server, then the login information
for the default sample account is joe and password.

You are now logged into the Pentaho User Console, and ready to start creating and running reports and dashboards.

Navigating the Pentaho User Console
The Pentaho User Console was designed to be intuitive to users accustomed to standard file managers like Windows
Explorer, and Web browsers like Firefox.

The first thing you will see after you log in is the quick launch Browser view:



 | Pentaho User Console Basics | 8

1. New Interactive Report - This button will open a new Interactive Report. This action can also be achieved by
clicking the New Report button in the middle of the screen, or selecting File -> New -> Interactive Report.

2. New Analysis Report - This button will open a new Analysis Report. This action can also be achieved by clicking
the New Analysis button in the middle of the screen, or selecting File -> New -> Analyzer Report.

3. New Dashboard - This button will open a new Dashboard. This action can also be achieved by clicking the New
Dashboard button in the middle of the screen, or selecting File -> New -> Analyzer Report.

4. Workspace - This button will open up the Workspace screen. The Workspace screen will report what you have
submitted to run in the background on the server. Within this screen, you can cancel reports that have not run yet,
and you can view or delete ones that have. This action can be achieved by going to View -> Workspace. You can
also toggle between the Workspace view and the Browser view within the View menu.

5. Toggle Browser - This button will allow you to show or hide the Browse Pane.
6. Browse Pane - The browse pane on the left allows you to navigate through your existing solution folders. Solutions

and content files such as dashboards and reports inside the folder. You can create and delete solution folders by
right-clicking inside the navigation pane. You can also examine information associated with solution folder contents
by right-clicking and selecting Properties.

Note:  If you do not have a Pentaho Dashboards Enterprise Edition entitlement, the New Dashboard button will
instead be Manage Content, which will open a dialog box that offers quick availability to the edit, share, and
schedule functions for existing content.

Creating a New Solution Folder

Follow the instructions below to create a new solution folder in which to save solution (content) files such as
dashboards, ad hoc, and analyzer reports.

1. Click the Toggle Browser button so that you can see the Browse pane on the left.

2. Scroll down to the end of the list of solution folders and right-click to display the New Folder dialog box.

Note:  If you want to create a sub-folder inside an existing solution folder, right-click on the existing folder and
select New Folder.

3. In the New Folder dialog box, type a name for your folder and click OK.

Note:  The repository is refreshed. This action may take a few seconds to complete.
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The new folder appears in the navigation pane.

Deleting a Solution Folder

Follow the instructions below to delete a solution folder.

1. Click Toggle Browser so that you can see Browse pane on the left.

2. Scroll down to the solution folder you want to delete, right-click, and select Delete.
You will be asked to confirm your delete request.

Danger:  Once deleted, all files and folders cannot be recovered. There is not a "trash bin" from which you
can recover lost work.

3. Click OK.

Note:  The repository is refreshed. This action may take a moment.

The folder disappears from the navigation pane.

Using My Workspace

My Workspace is a graphical overview of the reports and Pentaho Analyzer reports you've created and scheduled.
Click the triangle on the left side of each category to expand the elements it contains.

1. Waiting - This category lists all private schedules that will run in the future. Clicking Cancel will delete the schedule.
If you want to suspend a schedule, you should use the Suspend function of the My Schedules list instead.

2. Complete - Each report that has been run via a schedule will show up in this list. Every time the schedule executes,
it overwrites that report's previous entry in the Complete list.

3. My Schedules - This category contains a comprehensive list of your private schedules, including those that are not
currently waiting to run. This will be identical to your Waiting list unless you have suspended any of your schedules.

4. All Schedules - This is a combined list of public and private schedules under your control. It is only viewable by
administrator-level users.
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5. Public Schedules - This is a list of all public schedules set by the administrator from the Pentaho Enterprise
Console. You can run a public schedule manually, but you cannot change its interval through the Pentaho User
Console.

Reports that you've created or have access to will have options to the right of each report listing to suspend or run
them, and schedules have options to suspend, run, or delete them.

Creating Reports

Restriction:  Interactive Reporting and Analyzer are exclusive to Pentaho Analytics Enterprise Edition, and
require Pentaho Reporting and Pentaho Analysis Enterprise Edition licenses, respectively.

The Pentaho User Console provides you with two reporting components: Interactive Report and Analyzer Report.
Each of reporting component fulfills a specific reporting need. Read the description below to decide which reporting
component is right for you:

If Then

You want to create a quick operational or financial report that
answers an immediate business question such as, “Who are my top
performers this week?” or “What are the current inventory levels for
product X? ...“

You want a report that looks professional and provides you with
significant control over formatting elements such as fonts, font color,
column widths, background colors, column sorting, and more...

You want to create a quick prototype report that you can later
customize using Pentaho Report Designer...

Use Interactive Report.

You want to analyze business data quickly in an interactive
environment that focuses on the interaction, exploration, and
visualization of data...

You want to perform advanced sorting and filtering on your data;
you want to drill through reports into the underlying data...

You want to see chart visualizations that include conditional stop-
lighting...

Use Analyzer Report.

Important:  The old ad hoc reporting tool is still available for customers who need to edit legacy reports,
however, it has been deprecated and will be phased out in a future release.

Role and User Based Access

The Pentaho User Console has the ability to set up security access through the schema (for Analysis Reports) or the
metadata (for Interactive Reports). Schema may be edited using Schema Workbench and metadata may be editing
using the Metadata Editor. Within the Pentaho User Console, you can set permissions for specific users (Joe, Suzy) or
for specific roles (Administrator, North America Managers) to have access to particular types of data.

For example, you might allow users with the role of North America Managers to only have access to the North America
data, and APAC Managers to only have access to the APAC data. At the same level, you could allow Administrators
access to the data for all areas.
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Using Pentaho Interactive Reporting

Pentaho Interactive Reporting provides you with a Web-based, drag-and-drop interface that allows you to add elements
to your report layout quickly and easily.

Available features include:

• Font selection
• Column resizing
• Column sorting
• Ability to rename column headers
• Copy and past functionality
• Unlimited undo and redo functionality
• Ability to output reports as HTML, PDF, CSV, or Excel files
• Ability to display reports in a dashboard

Before you can create an Interactive Report you must have access to a data source provided by an administrator. The
data source for an Interactive Report is based on a metadata model. A metadata model presents the data you use in
reports in business terms; for example, users see Customers and Orders instead of CUST_TBLE or ORDR_TBLE.
Pentaho Metadata removes the need for you to know query languages, such as SQL. Queries are generated based
on the metadata selection. The metadata model allows you to create an Interactive Report without knowing the
complexities of the database structure. Some examples of metadata include the names of tables and columns. Also
included are the relationships between columns and tables, and security and access rules.

A metadata model is created using Pentaho Metadata Editor or generated by the Data Source Wizard (either through a
manually-entered SQL query, an auto-query written against a defined set of tables and joins in a relational database, or
a CSV file).

Note:  For information about data sources see Adding a Data Source in the Pentaho User Console.

Selecting a Data Source
The first step to creating an Interactive Report is selecting a data source. Data sources are provided to you by an
administrator or authorized user. For information about creating data sources, see Adding a Data Source in the Pentaho
User Console. Follow the instructions below to select a data source.

1. In the Pentaho User Console, go to File -> New -> Interactive Report. Alternatively, click the New Report icon on
the Pentaho User Console Quick Launch page, or, click the New Interactive Report icon on the console toolbar.
The Select Data Source dialog box appears.

2. Select the Data Source for your report and click OK.
The Interactive Reporting interface appears.

Creating a New Interactive Report
When you first open Interactive Report, the categories and fields associated with the data source you selected are
displayed in the left pane under Data. You can immediately begin to build the report by clicking and dragging fields onto
the report canvas. Interactive Reports provides you with live rendering of your report which means that you can see the
report layout as you build it. Formatting changes can be made on the fly.

Follow the instructions below to begin creating a new report.

1. To add your first column, click and drag a field from the Browse Pane and onto the report canvas.
The field becomes a column in your report. Repeat this step until you have all the columns of your report in place.

If you want to make sure subsequent columns appear in correct order, look at the vertical green line that appears
to the right or left of the first column. If you drag the selected field to the left and the green line appears, the new
column will appear to the left of the original column. If you drag the selected field to the right and the green line
appears, the new column will appear to the right of the original column.
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Note:  Do not worry if your column does not get placed correctly on the report canvas. To correct a
placement, drag the report header to the appropriate location. Click the undo/redo buttons in your toolbar if
you make a mistake.

2. If applicable, add one or more groups to your report. The grouping feature in Interactive Report allows you to group
the data in your report by one or more fields. For example, you could group your data by geographic region, by
product line, or both. If the field you want to group by is already a column in your report, click the column header and
drag it up above the other headers in your report. Release the mouse button when the horizontal green line appears.
You can also drag a field from the right pane and place it above the report headers to create your group.

Sometimes you need to group the data in your report by more than one field to get the data in the order you want it
to display. An example of adding more than one group is shown below. The report data grouped by Territory first
and then by Product Vendor. To nest a group, drag the field or column header beneath the original group.

Notice the small arrows next to the group name. In this example, the arrows point up indicating that both groups
are sorted in Ascending order. To change the sort order to Descending, click the arrow next to the group name or
make the change, under Group Sorting in the right pane.

You can save your report at this point or continue customizing it. See Saving Your Interactive Report for instructions.

Saving Interactive Reports
Follow the instructions to save your interactive report:

1. Click Save in the Pentaho User Console toolbar.
The Save dialog box appears.

2. In the File Name text box, type a file name for your report.

3. Browse to locate the folder in which to save your report.
The path to the folder which will contain your report appears in the Location text box.

4. Click Save.
The interactive report saves.

Filtering Reports
Filters restrict or limit the data that is presented in a report. For instance, you could filter the data to limit sales figures to
the first quarter of the year. Pentaho Interactive Reporting allows you to filter data using several different methods.

Adding a Filter

These steps use the Orders database that is part of the Steel-Wheels sample data to create a report that filters the
data.

1. Select Orders from the Select Data Source dialogue box that appears when you start Pentaho Interactive
Reporting. Click OK.

2. From the Available Fields panel on the left, drag Territory, Country, Product Line, and Total to the right side of
the report workspace.
The report will populate with Territory, Country, Product Line, and Total in that order.

3. Click on the Filters button to make the Filters Panel appear.

4. From the Available Fields panel, drag fields into the Filter Panel.

a) Drag Territory into the Filters Panel. In the dialogue box, click the Select from a list radial button. Move EMEA
into the Currently Included box and click OK.

b) Drag Total into the Filters Pane. In the dialogue box, select Sum from the first drop-down box, Greater Than
from the second drop-down box, and type 300000 into the field. Click OK.

c) Drag Territory into the Filters Pane. In the dialogue box, click the Select from list radial button. Move NA into
the Currently Included box and click OK.

d) Drag Total into the Filters Pane. In the dialogue box, select Sum from the first drop-down box, Less Than from
the second drop-down box, and type 500000 into the field. Click OK.

5. Click Apply Filter.
The filter applies to the workspace.
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Creating Advanced Filters

You can create filters on multiple groups of fields, rather than a single group of fields. Filters with multiple groups are
called advanced filters. To create an advanced filter, drag the fields into the Filter Panel and move items into multiple
groups by moving them up, down, and indenting them to create a hierarchy.

This example shows how to use the Order database, which is part of the Steel-Wheels sample data, to build a filter
that shows all orders that are less than $500,000 in North American and are greater than $300,000 in EMEA.

Follow these steps to create an advanced filter using the filter created in Adding a Filter on page 12.

1. Click the down-arrow on Total (Sum) Less Than 500000 and select Indent.

2. Click the down-arrow on Territory Exactly matches NA and select Move Down.

3. Click the down-arrow on Total (Sum) Greater Than 300000 and select Indent.

4. Click the down-arrow on Territory Exactly matches EMEA and select Move Down.

5. Click the down-arrow on the left AND/OR drop-down and select OR.

6. Click Apply Now to apply the filter to your data.

The workspace shows data that either has a Total sum that is less than 500,000 in North America or a Total
sum greater than 300,000 in EMEA.

Applying a Summary Function

You can assign a summary function to columns that contain numeric values in your report. A summary function is a
summarization technique that performs calculations on values in columns, groups, or in the entire report.

1. Click the down arrow next to a report column that contains numeric values.

2. Select Summary from the menu, then select your summary type.

Function Name Description

None No summary function assigned

Average Calculates the average value in a given column

Count Counts the items in a group or report, but does not
require a numeric value.

Max Identifies the highest or largest value in a column

Min Identifies the lowest or smallest value in a column

Sum Calculates a total sum of the group or report (group
level, and running total in the report footer)

The numeric values in the column update.

3. Save the report.

Applying an Aggregate Function

You can assign an aggregate function to columns that contain numeric and non-numeric values in your report.
Aggregate functions return a single value, (for example, Average, Maximum, Minimum) calculated from the values in a
column. For example, the sum of a column results from adding all the values in the column.

1. Click the down arrow next to a report column that contains numeric values.

2. Select Aggregation from the menu, then select your aggregation type.



 | Using Pentaho Interactive Reporting | 14

Function Name Description

None No aggregate function assigned

Average Calculates the average value in a given column

Count Counts the items in a column; does not require a
numeric value

Count Distinct Counts the distinct occurrences of a certain value in a
column; does not require a numeric value

Max Identifies the highest or largest value in a column

Min Identifies the lowest or smallest value in a column

Sum Calculates a running total sum of the specified column

The values in the column update.

3. Save the report.

Flagging a Filter Constraint for Use as a Dashboard Parameter

You can flag a filter constraint for as a parameter. The parameter name will appear under the Parameters tab in
Dashboard Designer when you place the report into a dashboard panel. The parameter(s) also appear and can be
edited when working in Report Designer

1. After you create your filter, type the parameter name in the Parameter Name text box.

2. Click OK.

3. Save your report.

The parameter is ready to be used in Dashboard Designer. To see if the parameter appears in Dashboard Designer,
insert your report into a dashboard panel. The parameter name will appear under the Parameters tab.

Adding a Filter on Date Fields

Follow the instructions below to add a filter that matches a specific value:

1. In the toolbar, click  (Filters).
The Filters Panel appears above the report.

2. Click and drag a date field from the right pane into the Filters area.
The Filters dialog box opens.

3. Next to the field name, select a date constraint from the list, then click the small arrow on the right to display the date
picker.

Note:  To create a "date range" you must add two filters: one for the start date, and one for the end date.

4. In the date picker select your date.

5. Click OK to save your filter.
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The report display updates as soon as the filter is added. The filter appears in the Filter box and an icon displays next
to the field name under the Data tab. Also, the number of filters added to the report appears next to the filter icon in the
toolbar.

You can edit the filter by clicking  (Edit). You can delete the filter by clicking .

Disabling Auto Refresh Mode in Interactive Reports
When you disable the Auto Refresh  mode in Interactive Report you can design your report layout first, including
calculations and filtering, without querying the database until you are done. Once the report layout is complete, you can
re-enable Auto Refresh mode. Data retrieval will occur once and your report will display the requested data. Disable
auto refresh if you want to reduce the number of queries executed against the data source or if you know that the data
source returns data slowly.

To disable Auto Refresh, click the small icon in the upper right corner of the Data tab to open the Query Setup dialog
box, then disable the Auto Refresh option.

Enabling Row Limit and Query Timeout
You can limit the number of rows that are displayed in your report. You can also limit the number of seconds a query
runs before a timeout occurs. Imposing row limits and timeouts on queries is important to avoid out of memory errors or
processes that consume too many resources on the database server.

Both options are available in the Query Setup dialog box. In the Data tab, click the small icon on the upper right corner
to open the Query Setup dialog box. Make your changes as needed and close the dialog box when you are done.

Refining Reports
Now that you have defined the data for your report, you are ready to begin refining some of the formatting elements in
your report.

Note:  See the Interactive Reporting Quick Reference section for an overview of formatting actions.

Editing Report Headers and Footers

To create the page headers, double click on the words, Top Left, (or Top Right), in the upper left or right corner of the
report.

A pop-up dialog box appears. You can:

• Delete the default wording, (Top Left/Right), in the text box and type a new header and press <ENTER>.
• Click Date and press <ENTER> to insert a date and time stamp in the page header. You can customize the date

and page count displays by adding your own text, such as, Today: $(report.date) instead of using the default,
$(report.date).

• Click #/Pages and press <ENTER> to insert the number of pages in the report as in 1/1 (page one of one).

Repeat this process for the Bottom Right and Bottom Left page footers.

Editing the Report Title

To edit the report title, double-click Untitled and type a title for your report in the available text box; press <ENTER>.

Reordering and Adjusting Columns

To reorder your column, select the column you want to move and drag it to your desired location. Alternatively, select
the column you want to move, click the down-arrow and select Move (Right or Left) from the menu.

To adjust your column width, select the column, then click on the vertical line that divides your column headers. A small
arrow appears. Move the arrow left or right to adjust your column width.
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Formatting Reports
Formatting options such as font color, size, and type, page justification, background color options, text alignment and
more, are available under the Formatting tab in the right pane. These options are standard and self-explanatory. The
sections that follow provide information about a subset of formatting options.

Changing the Report Template

To change a report template, click the General tab then use the right and left arrows to page through the available
templates. Click Select to see all templates. Answer Yes or No when you are asked if you want to keep any custom
formatting you have applied to the report. The report display updates with the new template.

Changing Page Format and Orientation

By default Interactive Report presents you with a page in Letter format (8.5" x 11"), a format used in the United
States. In addition, the report page displays in portrait mode. You may need to change both the format and the page
orientation.

To change page format, click the General tab, then click Page Setup. In the Page Setup dialog box, choose the correct
page format for your report from the list. Page margin measurements are shown in the lower portion of the dialog box.
You can adjust the measurements as needed. Click OK to save your changes.

To change page orientation, click the General tab, then click Page Setup. In the Page Setup dialog box, click on the
appropriate icon. Click OK to save your changes.

Changing a Column Header Name

To change a column header name, double click on the column header to display the input text box. Type the new
header name into the text box and press <Enter>.

Applying Copy/Paste Formatting

Use the copy/paste options in the under the Formatting tab to copy the formatting of one column to one or more
columns in your report. Select the column that contains the formatting you want to copy then click (Copy Formatting).
Select the column you want to apply formatting to and click (Paste Formatting).

Changing the Format of Numeric Values

If your column contains numeric values, you may need to change the formatting associated with those values. Select
the column that contains the numeric values that require a formatting change. Click the Formatting tab in the right
pane. Under Numeric Format, select the correct numeric format for the values in your column.

Note:  In some instances, you will notice that formatting has already been applied to your numeric values. For
example, monetary symbols are already included in sales figures. This formatting is inherited from the metadata
associated with the data source and can be overridden, if necessary.

Editing Interactive Reports
Follow the instructions below to edit your interactive report:

1. Browse the solution repository to locate your report.

2.
Right-click the report name and select Edit. Alternatively, double-click the report name to open it, then click 
(Edit) in the Pentaho User Console toolbar.

3. Edit your report as needed.

4. Save your report.
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Interactive Reports and Report Designer
Reports you create using Interactive Reporting can be opened in Report Designer for further customization. Pentaho
Report Designer is the most comprehensive report design tool in the Pentaho Business Analytics Enterprise Edition
and provides you with advanced formatting capabilities and the ability to connect to disparate data sources. Charts
and other report elements, including sub-reports can be added to a basic report. Below is a subset of Report Designer
capabilities:

• Connect to diverse data sources including relational data, Pentaho Analysis, Pentaho Metadata, flat files, java
objects, or stream data directly from Pentaho Data Integration transformations to design reports

• Create and view user prompts, including dynamic cascading prompts
• Add data visualizations such as charts, barcodes, sparklines, survey scales, and more
• Localize reports easily to support multi-lingual deployment with a single report file
• Embed HTML and JavaScript controls for dynamic and interactive online reports
• Fine-tune reports using the built-in interactive preview mode

Important:  Once you customize an Interactive Report using Report Designer, you can no longer edit the report
using the Interactive Reporting module in the Pentaho User Console.

Interactive Reports are saved as .prpti files. Report Designer report files have a .prpt extension. In the Pentaho User
Console, Interactive Reports are displayed with a special icon that differentiates them from reports that are created in
Report Designer.

If you want to create a new Interactive Reporting template, you must create it in Report Designer and place the template
in the Interactive Reporting templates directory.

For more information about enhancing Interactive Reports and building Interactive Reporting templates in Report
Designer, refer to the Report Designer User Guide.

Examining an Interactive Report in View-Only Mode
After you save your interactive report, browse for it in your solution repository. An Interactive Report is quickly identified
because its associated icon is unlike the icons of other repository content. Once the report appears, notice that there is
a toolbar that allows you or a report consumer to perform certain limited actions on the report. Hover over the icons in
the toolbar to see what actions you can take. These include, but are not limited to...

• Exporting a report as a PDF, HTML, Excel, or CSV file to be saved locally
• Adding filters for viewing report data
• Rearranging the report layout, such as moving, sorting, and removing columns from the report
• Editing page headers and footers
• Editing the report title

You cannot save the changes you have made to a report when you are in View-only model; however, you can click 
(Edit) in the Pentaho User Console toolbar to return to edit mode and save the changes you made.
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Interactive Reporting Quick Reference

General

Action Description

To hide tips on startup... • Disable Show tips on startup in the lower right corner
of the report canvas.

• Disable Show tips on startup in Preferences under
the General tab.

To show tips on startup... • Enable Show tips on startup in the lower right corner
of the report canvas.

• Enable Show tips on startup in Preferences under
the General tab.

To hide tips altogether... Click Hide Tips in the lower right corner of the report
canvas.

To disable menu buttons ... Disable Enable menu buttons in Preferences under the
General tab.

To enable menu buttons (down arrow next to a report
column)...

Click Enable menu buttons in Preferences under the
General tab.

To enable Select Distinct... Click the Query Setup icon in the Data tab to prevent
the report from displaying duplicate values in columns.
Enabling this option will list the different (distinct) values in
a table, exclusively.

To export a report... Click Export and select your export file type: PDF, Excel,
CSV or HTML. Exported files can be saved locally on your
computer.
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Fields and Columns

Action Description

To place a field on the report canvas... Click and drag a field from the right pane to the report
canvas. Alternatively, double-click a field name to place it
onto the report canvas.

Note:  For quick placement, click Layout in the
toolbar and drag the fields into the Columns area.
Alternatively, right-click a field name and select,
Column.

To place multiple fields on the report canvas... Press the <CTRL> key and select multiple fields in the
right pane, then drag the fields onto the report canvas.
The fields will become columns in the report in the order
in which they were selected.

To move columns left or right... • Click the report header and move the column to the
desired location.

• Right-click on the column header and select Move
> Right (or Left). Columns can also be moved as
needed by clicking the Layout button in the toolbar
and dragging the columns to the desired position.

To adjust column width... Click the column header to select it. Move your cursor to
the right or left until a small horizontal line appears. Drag
the line to the desired width.

To assign column width (percentage) Enter a value in the Column Width text box under the
Formatting tab.

To change the column name... Double-click the column name and type the new name in
the available text box.

To remove a column... Click and drag the column header to the right and place
the column into the trash can.

Grouping

Action Description

To add a group to a report... Click and drag a group field from the right pane up above
the column headers in the report. Release the mouse
button when the green horizontal line appears.

If the group field you want is a column in the report,
drag the column name up above the column headers in
the report. Release the mouse button when the green
horizontal line appears.

Note:  For quick placement, click the Layout
button and drag the fields into the Groups area.
Alternatively, right click on the field name you
want as your group and select, Group.

To add more than one group to a report... Click another group field from the right pane and drag it
above or below the previously placed group.

To change the sort order of a group... • Click the small arrow to the right of the group name to
change the sort order.

• Assign the sort order under Group Sorting in the right
pane
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Filtering

Action Description

To add a filter... • Click Filters in the toolbar, then drag a field into the
Filter area.

• Right-click on the field name you want to filter on,
(under the Data tab), and select, Filter.

• Select column name, click to open the context menu
and select Filter.

To edit a filter... Click the Edit icon next to the filter name to open the Filter
dialog box. Make your changes and click OK. Or you can
select a column name, click to open the context menu and
select, Filter.

To delete a filter... Click Filters in the toolbar, then click the Delete icon next
to the filter name.

To select a filter value from a list... Click Select from list in the Filter dialog box.

To find a filter value in a list... Type the first few characters of the value and click Find.
Entries are case-sensitive.

To include or exclude a filter value from a list... Click either the Includes or Excludes link next to Select
from list.

Alternatively, make a selection next to Currently in the
Filter dialog box.

To specify a specific filter value... Click Match a specific value, then select a constraint
from the list.

To create an advanced query ... Within the Filter Pane, click on the Advanced Filter
button in the bottom right hand corner. Enter a MQL
query.

Formatting

Action Description

To undo or redo previous actions... Within the toolbar, click the green left-pointing arrow to
Undo or the green right-pointing arrow to Redo.

To change the font type in a column header... Select the column header. Under the Formatting tab,
select font type from the available list.

To change font type in the column details... Select the column details. Under the Formatting tab,
select font type from the available list.

To change font color in a column header... Select column header. Under the Formatting tab, click
the text color icon to select font color from the available
list.

To change the font color in column details Select column details. Under the Formatting tab, click
(icon here) to select font color from the available list.

To change the column header background color... Select the column header. Under the Formatting tab,
click Background Color bucket icon. Select a color from
the color picker or create your own custom color.

To change the column details background color... Select column details. Under the Formatting tab, click
Background Color bucket icon. Select a color from the
color picker or create your own custom color.

To apply text justification... Select the report element column header or column
details. Under the Formatting tab, click the appropriate
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Action Description

text alignment option. Column headers can be formatted
separately from column details.



 | Using Pentaho Analyzer | 22

Using Pentaho Analyzer

Pentaho Analyzer is a tool that enables you to easily analyze your data.

Creating a New Analyzer Report
Pentaho Analyzer provides you with a rich drag-and-drop user interface that makes it easy for you to create reports
based on your exploration of your data. You can also display Pentaho Analyzer reports in a dashboard. Unlike standard
reports, which tend to be static or minimally interactive after they are created, Pentaho Analyzer reports allow you to
explore your data dynamically and to drill down into the data to discover previously hidden details. Pentaho Analyzer
presents data multi-dimensionally and lets you select what dimensions and measures you want to explore. Use the
Analyzer to drill, slice, dice, pivot, filter, chart data and to create calculated fields. Users of Analyzer reports can query
the data in a database without having to understand how the database is structured.

Note:  The field view in the sample report below is organized by Category (hierarchies and levels within a
dimension). You can organize the field view in your Analyzer report alphabetically (A-Z), by Number (measures)
- Text (names, categories, etc.) - Time (months, quarters, and years), and by Schema, which displays the
dimensions as defined in the Mondrian schema.

In this exercise, you will be creating a report that displays the actual versus budgeted expenses by region for each
department in the fictitious Steel Wheels company (SampleData).

Follow the instructions below to start creating the Analyzer report.

Note:  If you do not have access to Sample Data, adapt the instructions to your own data source.

1. In the Pentaho User Console menubar, go to File -> New and select Analyzer Report.
A Select Data Source dialogue box will appear.

2. Select your Schema and Cube from the list. For the purposes of this exercise, select SampleData:Quadrant
Analysis.
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Note:  The list of available schemas and cubes are provided by your administrator. A schema is the structure
of the relational database and includes tables, fields, views, and more. A cube is a data structure that allows
information in a database to be analyzed quickly and from multiple perspectives.

3. In the Available Fields panel on the left, click and drag Department to the Rows panel within the Layout panel.

The Department column appears in the workspace.

4. In the list of fields, click and drag Budget to the Measures area within the Layout panel.

The Budget column appears in the workspace.

5. Right-click the Budget column to display the Edit Column dialog box. Select Column Name and Format.

The Edit Column dialogue box appears.

6. From the Format drop-down box, select Currency ($) so that your values display as dollar amounts. Click OK.
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The data auto-updates and displays as currency.

7. In the list of fields, click and drag Actual to the Measures panel within the Layout panel.

The Actual column appears in the workspace.

8. Right-click the Actual column to display the Edit Column dialog box. Select Column Name and Format.
The Edit Column dialogue box appears.

9. From the Format drop-down box, select Currency ($) so that your values display as dollar amounts. Click OK.

10.Click and drag the Region column to the Columns panel within the Layout panel.
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11.At this point you have a functioning report and you can view your data in chart form. Click Switch to Chart Format
to examine your report data in a chart format. The default display is a bar chart but if you click Choose Chart Type
you can select a different chart type to display your data.

12.Save your report before continuing the exercise. In the Pentaho User Console, click Save As. When the Save As
dialog box appears, save your report as Regional Expense Report under /Steel Wheels/Analysis and click
OK.

Adding Filters to an Analyzer Report

Filters are used to restrict or limit the data that is presented in a report. For example, a report shows sales by product
line. A filter on Quarter restricts the data so that sales for the fourth quarter in 2010 only are shown. If you were to
add a regional filter of Europe, the report displays data pertaining to European sales in the fourth quarter of 2010,
exclusively. If you were to add a filter on the Product Line field to exclude Surfing, the report displays data pertaining
to European sales in the fourth quarter of 2010 that are not in the surfing product line, exclusively.

Follow the steps below to add a filter to your sample report:

1. Open the Regional Expense Report.

2. Under the report name click Show/Hide Filters next to No Filter in Use.
A workspace for filters appears at the top of the report.

3. Click and drag the Region field/column into the filter workspace.
The Filter on Region dialog box appears. Notice that the values, (Central, Eastern, Southern, and Western),
associated with the Region field are listed in the dialog box. You can choose one of these values or you can enable
Match a specific string to filter the report on a specific string of data.

4. Select Eastern from the list of values and click Add Selected to move it into the right pane.
Eastern appears with a green checkmark next to it in the right pane.
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5. Select Western from the list of values and click Add Selectedto move it into the right pane.
Western appears with a green checkmark next to it in the right pane.

6. Click OK to exit the dialog box.
Your sample report displays data for the Eastern and Western regions only.

Note:  You can click Undo or Reset to return to the previous version of the report.

7. Click OK and save your report.

Adding Query Parameters to Analyzer Reports

You must be logged into the Pentaho User Console, and have an Analyzer report open for editing in order to continue.

Follow the below procedure to parameterize your MDX query in Analyzer.

1. Right-click on the dimension member you want to create a parameter for, and select Filter from the context menu.

2. Select the level you want to set as the default parameter value, then click the right arrow to move it to the list on the
right.

3. Click the checkbox at the bottom of the window, then type in a name for the parameter in the Parameter Name field.

4. Click OK.

Your parameter is now created as a filter in Pentaho Analyzer. Whenever this Analyzer report is run, users will have a
selection of columns to filter by.

Note:  If you create a dashboard with this Analyzer report, then this filter can be used by Dashboard Designer as
a parameter as well.

Exporting an Analyzer Report

You can export a report as a PDF, XLSX, or CSV file.

1. In the Pentaho Analyzer toolbar, click on More > Export Report, and select the desired output format.
The Export dialogue box appears.

2. Specify the page formatting and click on the appropriate button to choose an option.

Option Description

Done Saves export settings but does not generate the export.

Export Applies the export option and generates the output. If
the report includes a chart, it is included in the report
along with the table view.

Cancel Discards all changes.

You must save the report if you want it to keep the export settings. Metadata for report author, source file location,
fields used and filter summary are included in the report.

Filtering by Member Properties

If a dimension has a number in parenthesis next to it in the field list, that means that it has member properties
associated with it. To constrain a dimension by controlling its member properties, follow the instructions below.

1. Open the field layout by clicking Show Field Layout button above the grid.

Depending on how you have them oriented, you will see your selected dimensions in either the Row Labels or Col
Headers fields.

2. Right-click on a dimension in the row label or column header fields, then select Show Properties from the context
menu.

A sub-menu with all available member properties will appear.

3. Check or un-check the member property boxes to add or remove them from the report, then click OK.

The analyzer report will refresh and show the filter choices you've selected.
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Configuring Drill-Down Links

To create reports based on specific number value data, you can implement drill-down links in Pentaho Analyzer. This
will turn all non-calculated number fields into links which, when clicked, bring up a configurable data grid that enables
you to quickly view more details for that data point without having to reconfigure your report. Follow the directions below
to turn on drill-linking.

Note:  Calculated members are unavailable for drill-down at this time.

Note:  Drill-down links will not work in reports that have filters that are not being used. If you have any filters in
an Analyzer report, they must be used in the report in order to view drill-down links.

1. Open the Analyzer report that you want to add drill links to.

2. Go to the More menu in the upper right corner of the report, and select Report Options from it.

3. Select the Show drillthrough links on Measure cells checkbox, then click OK.

The measure fields in your report will turn into links.

4. Click on a drill-down link to see a data grid that shows all of the available details for that value.

5. To add or remove columns from the grid, click on the down arrow on the right side of any column and select the
Columns sub-menu. From there you can select which columns you want to appear. You can also sort by ascending
or descending values for any column through this menu.

You now have drill-down links for numeric, non-calculated members.

Disabling Auto Refresh Mode

When you disable the Auto Refresh Report feature in Analyzer you can design your report layout first, including
calculations and filtering, without querying the database automatically after each change. You can enable the Auto
Refresh Report option at any time. When you enable data retrieval, your report will display the requested data.

Follow the instructions below to disable auto refresh and build a report.

1. In the Pentaho User Console menubar, go to File > New and select Analyzer Report.

2. Select the sample database Data Source, SteelWheels: SteelWheelsSales.

3. Because auto refresh is enabled by default, uncheck the Auto Refresh Report box.

4. Click OK.
The Analyzer workspace appears.

5. To begin creating your report layout, select a field and drag it to the Layout panel at the left of the workspace.
A message appears when you place the first field allowing you to refresh the report. Right-click menus are available
for each of the fields you have dragged to the field layout area. They also indicate the position of the fields once
they are placed in the report. Notice that the Analyzer workspace is disabled (greyed out) if you are not in live query
mode. You can click the enable/disable Auto Refresh button in the toolbar to toggle between the two modes.

6. Continue to build your report and query the database when the layout is complete. You may only build your report in
the field layout area when Auto Refresh is disabled.

7. When your report is complete, click Refresh in the pink band of the field layout area. Alternatively, use the toggle
button.

The Analyzer report updates based on the report definition and displays the results. You can continue to edit the report
as needed and click Refresh, or enable the Auto Refresh ability to run the query again.

Creating Hyperlinks to Pentaho Solution Repository Content

This feature allows you to create hyperlinks in an Analyzer report that will link to content in the Pentaho Solution
Repository.

The instructions below show you how to create hyperlinks to content inside your Pentaho Solution Repository (reports,
action sequences, etc.). You must adjust the instructions to work with your own data.

Important:  Hyperlinks take precedence over the drill down feature in charts. That means that if a hyperlink has
been defined and you click on a bar in a bar chart, for example, the data associated with the hyperlink, (not the
drill down chart), displays. See Drilling in Charts for details about drill down feature in charts.
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1. Create a simple Analyzer report.

2. Select a row label or column header, right-click, and choose Hyperlink.

Note:  In the example above, Department is a row label and Region is a column header. Under these, are
the individual members that belong to that field/level (for example, Executive Management, Finance and so
on are members of Department).

The Link on (Name of Field Level) appears.

3. Click Enable Link to activate the hyperlink feature.

You are not creating a hyperlink to the field header itself but rather to the members under the field level. You can
disable linking at any time by clearing the Enable Link checkbox.

4. Click the down arrow next to Link to and choose Pentaho Repository File.

5. If you choose Pentaho Repository File, you can link to a report (.prpt), an action sequence, or any other file inside
the Pentaho Solution Repository which contains a parameter that can be associated with the content in your
Analyzer report. Click Browse to locate your file in the Pentaho Repository. When you have found the file click
Open.
The Link on Field Name dialog box appears. If a destination parameter that matches the field name in your
Analyzer Report is found, field name is associated to that parameter. Click the checkbox next to the destination
parameter name to enable it.

If there are more parameters available for linking in the report or other content, they are also listed. You can override
the values to the available parameters or leave them as is. You can also define how hyperlink content will display
(Open in New Tab, Window, Current Window). Finally, you can enter a Tool Tip that displays when users hover
over the hyperlinks.

6. Click OK.
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Hyperlinks appear in your Analyzer report. Click on the links to make sure the content associated with them appears
correctly.

7. Save your Analyzer Report.

Creating Hyperlinks to a URL

This feature allows you to create hyperlinks in an Analyzer report that will link to a URL for system to system linking, for
example.

The instructions below show you how to create hyperlinks to a URL. You must adjust the instructions to work with your
own data.

Important:  Hyperlinks take precedence over the drill down feature in charts. That means that if a hyperlink has
been defined and you click on a bar in a bar chart, for example, the data associated with the hyperlink, (not the
drill down chart), displays. See Drilling in Charts for details about drill down feature in charts.

1. Create a simple Analyzer report.

2. Select a row label (or column), right-click, and choose Hyperlink. In the example below, Line is row label and Years
is a column header. Under these, are the individual members that belong to that field/level; for example, Executive
Management, Finance, and so on are members of Line.

The Link on (Name of Field ) appears.

3. Click Enable Link to activate the hyperlink feature.

You are not creating a hyperlink to the field header itself but rather to the members under the field. You can disable
linking at any time by clearing the Enable Link check box.

4. Click the down arrow next to Link to and choose URL.
The Link on Field Name appears.

5. Enter the URL path. You must use the {FieldNameInsideCurlyBraces} format to pass a parameter in your URL as
shown in the example below where {Years} is the parameter:

http://www.bing.com/search?q={Years}

You can also define how hyperlink content will display (Open in New Tab, Window, Current Window). Finally, you
can enter a tool tip that displays when users hover over the hyperlinks.

6. Click OK to return to your report.
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Hyperlinks appear in your Analyzer report. Click on the links to make sure the content associated with them appears
correctly.

Simple Conditional Formatting of Measures

Conditional formatting in the Analyzer data grid means that cells will be physically affected by the data they contain.
The most common form of conditional formatting is stoplight reporting, where cell backgrounds are colored red, green,
or yellow depending on user-defined thresholds. Analyzer offers some simple pre-defined methods of conditionally
formatting numeric data. Follow the directions below to implement conditional cell formatting.

1. Right-click a measure in the grid, then select Conditional Formatting from the context menu.

A sub-menu with conditional formatting types will appear.

2. Select your preferred number format from the list.

The analyzer report will refresh and apply the formatting choice you specified.

Conditional Formatting Types

Indicator Type Description

Color scale The background cell color will be shaded according to
the value of the cell relative to the highest and lowest
recorded values in that measure. There are several color
progressions to choose from.

Data bar The cell background is partially filled with a solid color
proportional to the scale of the cell's value relative to the
highest and lowest recorded values in that measure.

Trend arrow An upward or downward arrow is displayed to the right of
the cell value depending on whether it contains a positive
or negative value.

Analyzer Visualizations
Pentaho Analyzer offers many ways to visually display data. These graphics are called visualizations, and include
maps, charts, and grids.

Setting Chart Options

You can modify the aesthetics of a chart within Instaview by clicking Chart Options within the Properties panel in View
mode. These options enable you to define how to display a chart; change a chart's colors, add a legend, and more. You

can also access the Chart Options dialog box by clicking More actions and options  on the Analyzer toolbar and
select Chart Options.

General

Option Description

Background Fill type defines the background color of the chart and the
specific fill colors used. A Gradient will result in a gradual
color transition in the fill color. Choose the color you want
from the available color pickers (Fill Color, End Color) You
can select not to have a fill color (None), or select a single
background color (Solid).

Labels Allows you to select a font type, size, formatting, and color
of the labels in your chart.

Axis Allows you to adjust the axis range. When set to Auto
Range, the chart will scale based on the data. If you
have a time series chart, you may want to set the range
manually so that figures, (not close to the 0 axis), display
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Option Description

correctly; (see image below). Select a Scale option to
manage instances where numeric values in a chart are so
long that they affect the display.

Legend

Option Description

Show Legend Allows you to enable to disable the legend display

Position Allows you to select the placement (Top, Right, Bottom,
Left) of the legend on the chart

Background Color Allows you to select a background color for the legend

Font Allows you to set the font type, size, format, and color
associated with your legend

Other

Option Description

Line Charts Allows you to set the Bullet Style for points on a line chart
and assign Line Width

Multi-Charts Allows you to define the number of charts that display
when using the Multi-Charts feature

Domain Limit Allows you to limit the number of plot values that display
in a chart.

Displaying Multi-Charts in Analyzer

The Analyzer multi-chart feature allows you to display multiple charts in a single Analyzer report. For example, use this
feature when you want to display the same data over different years. The multi-chart feature prevents you from having
to create separate filters and reports.

1. Create or open an Analyzer report.

Important:  You must have Auto-Refresh Mode disabled to use the Mutli-Chart feature.

2. Click the Switch to Chart Format button to change to chart format.

3. Move the appropriate fields into the Multi-Chartsection.
The field auto populates with the different charts dependent upon the level placed in the Multi-Chart field.

4. Save the report.

Geography Map Visualizations In Analyzer

Geo maps enable you to visualize data on a geographic map. This visualization type will plot a pin on a map based on
the location attribute used. You can then use a measure to color-code the pen and/or use a measure to specify the size
of the pin. If your model has geographic annotations then the location information will be retrieved by the geoservice
automatically.
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Customizing Geography Map Visualizations In Analyzer

The Properties panel enables you to customize the appearance of map visualizations.

The Pattern drop-down box allows you to decide the way the color of the pins populate. The appearance does not
denote any of the data, it is solely for aesthetics. You have the option of selecting:

• Gradient
• 3 Step
• 5 Step

The Color  drop-down box allows you to decide which colors denote large measures and which colors denote smaller
measures. The color denotes the size of the data, from small to large. You have the option of selecting:

• Red Yellow Green
• Red Yellow Blue
• Blue Scale
• Gray Scale

You also have the option of checking the Reverse Colors box, which will allow you to choose the inverse colors so they
appear large to small.
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Scatter Chart Visualizations In Analyzer

Scatter charts allow users the ability to visualize data on a graph. This visualization type will plot a bubble on a graph
based on the attributes used. You can then use a measure to color-code the bubble and/or use a measure to specify
the size of the bubble.

Customizing Scatter Chart Visualizations In Analyzer

The Properties panel enables you to customize the appearance of scatter chart visualizations. Click on the Chart
Options button within the Propertiesto make the Chart Options dialogue box appear.

The Chart Options drop-down box allows you to customize your chart. Within the four different tabs, you have the
ability to choose:
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• Chart fill type. If you choose a fill type other than none, you can customize the color (or colors if you choose a
gradient).

• Font type, size and emphasis for the labels
• Axis ranges
• Legend visibility
• Legend position
• Legend Background appearance (if it appears and if so, what color)
• Font type, size, and emphasis for the Legend
• For multi-charts, the number of charts per row
• The Domain Limit maximum number of plot values

Heat Grid Visualizations In Analyzer

Heat Grids allow you the ability to visualize data so you can identify patterns of performance. This visualization type will
color-code your results so you view complex business analysis in an easy-to-understand visualization.

Customizing Heat Grid Visualizations In Analyzer

The Properties panel enables you to customize the appearance of map visualizations.
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The Pattern drop-down box allows you to decide the way the color of the pins populate. The appearance does not
denote any of the data, it is solely for aesthetics. You have the option of selecting:

• Gradient
• 3 Step
• 5 Step

The Color  drop-down box allows you to decide which colors denote large measures and which colors denote smaller
measures. The color denotes the size of the data, from small to large. You have the option of selecting:

• Red Yellow Green
• Red Yellow Blue
• Blue Scale
• Gray Scale

You also have the option of checking the Reverse Colors box, which will allow you to choose the inverse colors so they
appear large to small. You may also change shape of the measures within the Shape: drop-down box. The measures
can be alternated between Square to Circle.

The Properties panel enables you to customize the appearance of scatter chart visualizations. Click on the Chart
Options button within the Propertiesto make the Chart Options dialogue box appear.
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The Chart Options drop-down box allows you to customize your chart. Within the four different tabs, you have the
ability to choose:

• Chart fill type. If you choose a fill type other than none, you can customize the color (or colors if you choose a
gradient).

• Font type, size and emphasis for the labels
• Axis ranges
• Legend visibility
• Legend position
• Legend Background appearance (if it appears and if so, what color)
• Font type, size, and emphasis for the Legend
• For multi-charts, the number of charts per row
• The Domain Limit maximum number of plot values

Creating a New Analysis View

Note:  JPivot is deprecated; Pentaho Analyzer is the more modern Enterprise Edition replacement.

To create a new analysis view, follow this process.

1. In the File menu, select the New submenu, then click Analysis View (Legacy).

2. Select the appropriate schema and cube from the drop-down lists.

3. Click OK to continue.

A fresh analysis view will open in a new tab.

4. Click the + icons next to each column you want to drill down into.

5. To change the filter, column, and row data, click the Open OLAP Navigator button, on the left end of the toolbar.

The OLAP Navigator will appear above your analysis view.

6. To add a dynamic chart, click the Chart button toward the right side of the toolbar.

A new chart will appear below your analysis view. It will change dynamically according to the drill-down you select.

7. When you're finished exploring your data through an analysis view, you can selecting Save from the File menu, or
by clicking the disk icon in the left side of the toolbar.

You now have an analysis view, which enables you to drill down to the minutest of details stored in your database.
Using this analysis view, you can create an interactive dashboard, or share your findings with other Pentaho User
Console users.
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Using Pentaho Dashboard Designer

Restriction:  Dashboard Designer is exclusive to Penatho Analytics Enterprise Edition, and requires a
Dashboards Enterprise Edition license.

Creating a dashboard in Dashboard Designer is as simple as selecting a layout template, theme, and the content you
want to display. In addition to displaying content generated from action sequences, Interactive Reporting, and Analyzer,
Dashboard Designer can also include:

• Charts: simple bar, line, area, pie, and dial charts created with Chart Designer.
• Data Tables: tabular data.
• URLs: Web sites that you want to display in a dashboard panel.

Dashboard Designer also has dynamic filter controls, which enables end-users to change a dashboard's details by
selecting different values from a drop-down list, and to control the content in one dashboard panel by changing the
options in another (content linking).

Creating a New Dashboard
You must be logged into the Pentaho User Console. Follow the instructions below to create a new dashboard:

1. In the Pentaho User Console quick launch bar, click New Dashboard. Alternatively, you can click File > New >
Dashboard or click New Dashboard.

2. In the edit pane (lower portion of the page), click Properties, and enter a title for your dashboard page in the Page
Title text box.
The name you entered appears on the top left corner of the dashboard. This name helps you identify the page if you
want to edit, copy, or delete it later.

3. Click Templates to select a dashboard layout.
A blank dashboard with the layout you selected appears.

4. Click Theme to select a theme for your dashboard.
The theme you selected is applied to your dashboard.

You now have the basic framework for a Pentaho dashboard.

Working with the Chart Designer

The Chart Designer allows you to create bar, pie, line, dial, and area charts that can be added to a dashboard. Below
are the general steps associated with creating a chart:

1. Select a data source.
2. Build a query.
3. Set the data definitions: values, series, category.
4. Select a chart type and theme.
5. Enter labels for the chart title, and x,y axes.
6. If applicable, adjust scaling and label rotation.
7. Place your chart in the dashboard.
8. Save your dashboard.

If you are new to charting, here are guidelines that may help you determine what type of chart is best suited for the data
you want to present in your dashboard:

Bar Charts

If you want to compare items during a specific time period, consider using a bar chart. Key words to think about when
creating a bar chart are compare or rank. For example if you want to compare items sold to show which one made
the most profit, you might create a bar chart that ranks the products from the lowest to highest profit. The bar's length
determines its ranking; the label identifies the item. Bar chart data can be presented horizontally or vertically depending
on your requirements.
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Pie Charts

If you are comparing parts of a whole, consider using a pie chart. Key words associated with charts include, portion,
share, and percentage. If for example, you want to demonstrate the proportion of the company's budget spent on health
insurance, use a pie chart. To make the chart easier to read, limit the number of slices to five. Pie charts can also be
exploded, which means certain slices are pulled away from the remainder of the chart for emphasis.

Line Charts

Line charts are useful for showing changes over time. Key words associated with data that is best suited for a line chart
are trend, growth, and decline. If, for example, you want to show how product sales have changed over five years, use
a line chart. The slope of the line helps users quickly identify the direction of the trend.

Dial Charts

Dial charts are often associated with Key Performance Indicators (KPIs). Dial charts are circular and contain a scale,
a needle, and one or more a dial sectors. The dial sector is used to identify a specified area on a dial chart using
a particular color. For example, you could have a dial plotting inventory with a minimum dial value of 10000 and a
maximum dial value of 50000. There could be a red dial sector for the region between 2000 and 4000 indicating that if
the needle is in this area, there is a danger of a supply inventory shortage.

Area Charts

Area charts can be used to show a comparison of the same thing during different points in time. Area charts are
not designed to provide exact data but they do give users visual clues of the relative sizes of the items they are
representing.

Adding Data to a Chart

Before you can start creating a chart you must select a data source that contains the data you want to use. You must
then define the data that will be displayed in the chart.

Note:  If you are unsure what chart type is best for displaying your data, see Choosing the Correct Chart Type
for more information.

Follow the instructions below to add data to your chart:

1. In the Dashboard, choose a dashboard panel and click  (Insert) and select Chart.
The Select a Data Source dialog box appears.

2. Select the data source from the list of available choices. The data source contains the content you want to display in
your chart.
The Query Editor appears.

3. The Query Editor allows you to retrieve dynamic data from a database for display in a chart. Defining your query is
the first step in ensuring that the correct data is selected. In the Query Editor, click (+) next to a category name to
display its associated table columns.

4. Click the small green arrow to place the column name under Selected Columns. In the example below, the
Customernumber column has been selected and moved under Selected Columns. Notice that the column names
appear under Selected Columns. Continue adding columns as needed.
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5. Now add the Conditions; these are your constraints that filter what you are selecting. You can add multiple
conditions. In the example below, the search is limited to customer numbers.

Under Combine, you can select your constraint (and, or, and not, or not) from the drop-down list. Under
Comparisons you can click the drop-down list to display options for comparisons, =, <, >, and so on; (for example,
where the customer number is equal to 144 or 145). You can also select an aggregation type from the drop-down list
for table columns that contain numeric data. The table below contains a definition for each aggregate type:

Aggregate Type Description

SUM Sums a column's values

COUNT Counts a column's values

AVG Averages a column's values

MIN Selects the minimum column value

MAX Selects the maximum column value

Note:  Click Preview at any time to view the data associated with your query.

6. Add the columns that you want to Order By. The ordering of the selected data is accomplished by one or more
columns in a table. For example, you can sort the data by customer name and address.

7. Click OK in the Query Editor when you are done.
The Chart Designer appears.

8. Under Data, click the drop-down arrow to display and select the table columns.
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Data Definition Description

Series Column Series show up as the individual columns on a bar chart
and as individual lines in a line chart. Area charts display
each series as a point.

Category Column Categories are displayed as bars or groups of bars on
the x-axis (horizontal axis). In line charts, categories are
usually associated with time periods. In area charts, the
x-axis displays the category labels.

Note:  If you don't want to display categories,
select None.

Values Column The value is always numeric. The value determines the
height of columns in a bar chart and the height of lines in
a line chart. In area charts, the y-axis values determine
the heights of the points.

A preview of the chart appears in a box in the upper-right corner of the Chart Designer as you select your options.

9. Under Chart Type, click on a chart type to select it.

Note:  By default, pie and dial charts display in "animated" Flash mode. You can turn animation off by
disabling the Animated check box in the Chart Designer. Animated charts bring focus to important aspects
of your data. For example, animation allows you to bring out a data point if it reaches a critical value, such as
high or low sales numbers.

If you selected a pie or dial chart, see Working with Pie Charts or Working with Dial Charts, respectively.

10.Under Theme, select a theme from the list.
The theme is applied to your chart.

11.Enter the labels for the Chart Title, X Axis Title (horizontal axis), and Y Axis Title (vertical axis).
Entries are displayed in the chart preview.
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12.Click Apply to see the chart preview.

13.Click OK display your chart in the dashboard panel.

Working with Pie Charts

A pie chart gives dashboard consumers an immediate visual clue of the relative sizes of the shares of a whole.
Categories are represented by individual slices. The size of the slice in a pie chart is determined by the value.

You can animate a pie chart if you want its pieces to be exploded, which means that the individual slices of the pie can
be pulled away from the rest of the pie.
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To animate a pie, enable Animated check box in the Chart Designer.

Working with Dial Charts

For dial charts to display correctly, you must enter values for your range and the chart title. In the example below, the
dial chart preview is displaying ranges associated with sales. Notice that each dial sector is represented by a color, red,
yellow, or green. The needle is positioned in the 220796.48 range, indicating that total orders, while not stellar, are not
near the danger zone indicated by the red sector in the dial.

Changing Dial Sector Colors

You can change the color of a dial sector by clicking the small down arrow in the color boxes associated with Range.
Select a color from the palette so that you can preview it on your dial chart. Click Apply to preview your dial chart. Click
OK to place your dial chart into the dashboard.
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Correcting Scaling Issues

Use the scaling feature in instances where numeric values in a chart are so long that they affect the display.

1. Preview your chart in the Chart Designer.

2. Under Scale, click to display the drop-down list of scaling options. In the example below, the scaling option used is
"1000." Notice the change in the display of numeric values when scaling is applied. Users of the chart can see actual
values when they hover over the bars in the chart.

3. Click OK to display the chart in the dashboard.

Note:  The scaling feature is available for all chart types except pie.

Rotating Chart Axis Labels

If your chart axis labels become unreadable because they are too long, Label Rotation may correct the problem.

1. In the Chart Designer, display your chart.

2. Under Label Rotation, select Diagonal or Vertical and click Apply.
The labels display with the rotation you set.

3. Click OK to display the chart in the dashboard panel.

Editing a Chart

Follow the instructions below to edit a chart.

1. In the Dashboard Designer, select the panel that is displaying the chart you want to edit.

2.
In the upper right corner of the panel click (Edit)
The Chart Designer appears.

3. Click Edit Query.
The Query Editor opens.

4. Edit the query as needed and click OK.
The Chart Designer appears.

5. Select the appropriate data definitions to build the chart.

6. If applicable, change the chart type and theme and click Apply to see a preview of the edited chart.

7. Click OK to display the chart in the dashboard.

Adding a Data Table to a Dashboard

The Data Table feature allows you to display a tabular representation of a database query in a dashboard. It also allows
you and consumers of the dashboard to manipulate the display of the data in the data table, while in the dashboard. For
example, users can resize, sort, and change the order of columns. Follow the instructions below to add a data table to
your dashboard.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select Data Table.
The Select a Data Source dialog box appears.

3. Select a data source from the list of available data sources and click OK.
The Query Editor opens.
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4. Begin building your query. Click (+) next to the category name to display its associated table columns. When the
column names appear, click to select the column that contains the data you want displayed in your data table.

5. Click the small yellow arrow to place the column name under Selected Columns.

6. Now add the Conditions; these are your constraints that filter what you are selecting. You can add multiple
conditions.

Under Combine, you can select your constraint (and, or, and not, or not) from the drop-down list. Under
Comparisons you can click the drop-down list to display options for comparisons, =, <, >, and so on; (for example,
where the customer number is equal to 144 or 145). You can also select an aggregation type from the drop-down list
for table columns that contain numeric data. The table below contains a definition for each aggregate type:

Aggregate Type Description

SUM Sums a column's values

COUNT Counts a column's values

AVG Averages a column's values

MIN Selects the minimum column value

MAX Selects the maximum column value

Note:  Click Preview at any time to view the data associated with your query.

7. Add the columns that you want to Order By. The ordering of the selected data is accomplished by one or more
columns in a table. For example, you can sort the data by customer name and address.

8. Click OK in the Query Editor when you are done.
The Data Table appears in the dashboard panel.

Updating the Data Table Display

You can edit the data table display directly in the dashboard panel.

Sorting Column Data

To change the sort order data under a column, click the drop-down arrow in the header and choose Sort Ascending or
Sort Descending. You can also hide one or more columns by disabling the appropriate check boxes next to the column
names.

Adjusting Column Width

You can adjust the width of a column by clicking the right border of the column header and dragging it to the right or left.
Release the mouse button when you are done.
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Moving Columns

To move the placement of a column, click and drag the column it to the appropriate location in the Data Table as shown
in the example below:

Paginating

The pagination feature allows you to page through a large number of records.

Adding a Report Designer Report to a Dashboard

Follow the instructions below to add a report created with Report Designer.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select File.
A browser window opens.

3. Locate the appropriate report file.

4. Click Select to place the report inside the dashboard panel.

Pagination control arrows at the top of a report allows you to scroll through long reports. Notice that the report file
name, Inventory.prpt, appears under Content: in the dashboard edit pane in the sample below. This sample report
contains parameters. You can enter values manually and link them to a dashboard filter in the text boxes under
Source. When the report renders again, the parameter value(s) you entered are included in the report.
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Important:  If you select a Report Designer file to place in a dashboard, but do not supply values for required
parameters, the report will show up blank.

Adding an Action Sequence to a Dashboard

Follow the instructions below to display the contents of an .xaction file in a dashboard.

Note:  Generally, .xaction files are provided to you by an administrator. An .xaction file may contain a report, a
chart, or other type of content.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select File.
A browser window opens.

3. Locate the appropriate .xaction file.

4. Click Select to place the contents of the file inside the dashboard panel.

Notice that the file name appears under Content: in the dashboard edit pane of the sample below. This sample
chart contains parameters, (screen_res, Region), and default values (large, NA).
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5. Save your dashboard.

Adding an Analyzer Report to a Dashboard

Follow the instructions below to display an Analyzer report in a dashboard.

1. Select a panel in the Dashboard Designer.

2. Click Insert and select File.

3. Locate the appropriate Analyzer report and click Select.
The Analyzer Report appears inside the dashboard panel.

Adding a Web Site to a Dashboard

Follow the instructions below to display contents of a Web site in a dashboard panel. You may need administrator
privileges to display a Web site content in a dashboard.

1. Select a panel in the Dashboard Designer.

2. Click  (Insert) and select URL.
The Enter Web site dialog box appears.

3. Enter the Web site URL in the text box and click OK.

4.
If applicable, click (Edit) to make changes.

5. Save your dashboard when you are done.

Implementing Filters
Filters display a subset of data based on the dashboard user's point of view. For example, a European user may only
want to see EMEA region sales data, whereas the dashboard's default region is the NA region.
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Note:  To ensure that a filter links to the correct content in a dashboard, the content to which you are linking
(data table or chart) must contain at least one parameter.

Below are general instructions below for adding filters to your dashboard:

1. In the dashboard page, select Edit (the pencil icon), which will make the Objects pane appear.

2. Under General Settings, select Prompts.
The Prompts pane appears on the right. No filters are listed if this is the first time you are assigning filters.

3. To display a filter toolbar to users of the dashboard, enable Show Prompt Toolbar.
The prompt toolbar appears at the top of the dashboard.

4. Click the Add button to start adding filters.
The Filter Properties dialog box appears.

5. In the Filter Properties dialog box, type a display name for the control label. For example, "Region."

6. Enable Display Name as Control Label if you want users to see the display name in the filter toolbar.

7. Select your control type. Control types define how your filter values are selected; for example, in a drop down list,
radio button, checkbox, and so on.

The table below contains a description of each control type.

Control Type Description

Drop Down Users select a filter value from a drop-down list.

List Users select a filter value from a scrolling list. This filter
control supports multiple selections.

Radio button Users click a radio button to select a filter value.

Checkbox Users enable a checkbox to select a filter value. This
filter control supports multiple selections.

Button User click a button to select a filter value. This filter
control supports multiple selections.

Text Field Users enter a text string or number into a text field
manually.

Date Picker Users examine filter values based on calendar date.

Your dashboard now has a filter.

If you plan to provide hard-coded names and values for your dashboard users, or produce a dynamic filter list, continue
on to the next few sections.

Creating a Static List of Options

You must have a data table or chart that contains at least one parameter for your filter control to function correctly.

When you create a static list, you define a static list of options to present to the dashboard user. Each option consists of
a display name that appears in a drop-down list and a value that is used to restrict the data query in the filter toolbar as
shown in the example below:
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Follow the instructions below to create a static list:

1. In the dashboard page, under General Settings, select Prompts.
The Prompt Pane appears on the right. No filters are listed if this is the first time you are assigning filters.

2. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

3.
Click  (Add) to add a filter.
The Filter Properties dialog box appears.

4.
Click on an icon to select your Filter Control type. In the example above, the  (Drop Down) control was used.

5. Ensure that Static List is selected under Type. Static List is the default selection.

6.
Click  (Add).
The List Value dialog box appears.

7. In the List Value dialog box, enter the label and a value for the first option in the list. The label is the option that is
visible to dashboard users; the value is passed as the parameter's source value.

8. When you are done adding labels and values, click Close to exit the List Value dialog box.

9. In the Prompt dialog box, change the control properties (filter option) that will appear first in the filter control selecting
another label from the list under Use First Value.

10.In the dashboard, select your chart or data table. Click the Parameters tab and choose another Source for the
parameter from the list. That source should be the name of your filter control; in this example, Select Territory.
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The original default value (Source) for the {Territory} parameter was NA but for the filter to display correctly, the
Source was changed to Select Territory in the dashboard so that the filter control could drive the content in the
data table.

11.Click OK to exit the Filter Control dialog box.
The filter options are displayed to the dashboard user when viewing the data table.

12.Click OK to exit the Filter Properties dialog box and save your dashboard.

Creating a SQL List

You must have a data table or chart that contains at least one parameter for your filter control to function correctly.

When you create an SQL List, you are using a SQL query to dynamically retrieve a list of display names and
corresponding values directly from a relational database as shown in the example below:

a

Note:  You must have administrative permission to create SQL-based filters.

Follow the instructions below to create a SQL List:
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1. In the dashboard page, under General Settings, select Prompts.
The Filter Editor appears on the right. No filters are listed if this is the first time you are assigning filters.

2. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

3.
Click  (Add) to add a filter.
The Filter Properties dialog box appears.

4. In the Filter Properties dialog box, enter a Name for your filter.

5. Enable the Display Name as Control Label, if appropriate.

6. Click the appropriate icon to select your filter control. In the example above, the Radio Button control was selected.

7. Under Type, select SQL List.

8. Select the data source (Connection) that contains the content you need to set options from the drop-down list.

9.
Click  (Edit) to display the Query input text box.

10.Type the SQL query in the area provided for you. If you enter a parameter query, use the following format
${parametername} and provide a default value for the parameter.

11.Click Test to ensure that your SQL query is displaying the correct values.

Note:  Use a SQL query that returns two columns — one for the display name and one for the value.

12.Adjust your SQL query as needed and click OK.

13.Under Control Properties, enter a Default Label/Value for the initially selected option in your filter control.

14.Select a Label to display in the filter control; this is the user-friendly name that users will see in the dashboard.

15.Select the Value; this is the field that is passed as the parameter's source value.

16.If applicable, select your Display type from the list.

Note:  Some filter controls allow you to choose the position of your filter options. If you have a long list of
options, for example, a list of cities, you can change the Display type to horizontal.

17.Click OK.

The list of values appear in the filter toolbar in the dashboard.

Creating a Metadata List

You must have a data table or chart that contains at least one parameter for your filter control to function correctly.

When you create a Metadata List, you are defining a query to retrieve a list of display names and corresponding values
from a metadata data source provided by your administrator.
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1. In the dashboard page, under General Settings, select Filters.
The Filter Editor appears on the right. No filters are listed if this is the first time you are assigning filters.

2. To display a filter toolbar to users of the dashboard, enable Show Filter Toolbar.
A placeholder for the filter toolbar appears at the top of the dashboard.

3.
Click  (Add) to add a filter.
The Filter Properties dialog box appears.

4. In the Filter Properties dialog box, enter a Name for your filter.

5. Under Data Type, select Metadata List.

6. Click Select to choose the data source that contains the content you need to set options from the drop-down list and
click OK.
The Query Editor opens.

7. In the Query Editor, build a query to select either a single column (that represents both a name and a value), or two
columns representing the display names and corresponding values.

Note:  If a single column query is defined the values of that column will be used for both the display names
and the values.

8. Click OK to exit the Query Editor.
Your options appear under Selected Items in the Filter Properties dialog box.

9. Under Control Properties, enter a Default Label/Value for the initially selected  option in your filter control.
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10.Select a Label to display in the filter control; this is the user-friendly name that users will see in the dashboard.

11.Select the Value; this is the value in the database that is associated with the Label you selected in the previous step.

12.If applicable, select your Display type from the list.

Note:  Some filter controls allow you to choose the position of your filter options. If you have a long list of
options, for example, a list of cities, options may not appear correctly in the user console unless you change
the Display type to Horizontal.

13.Click OK.

The list of values appear in the filter toolbar in the dashboard.

Creating a Cascading Filter

A cascading filter changes based on a value a user selects. When the value in the drop down list, (Country), changes,
the filter is automatically applied to the second filter, (City) thus changing its values.

The example above was created using a Metadata List for the drop down filter (Country).
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A SQL List that included a parameter, ${selected_country}, in its associated query was used for the checkbox filter
(City).
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The Default Value for the selected_country parameter was set to USA with New York City (NYC) as the initially
selected value for the checkbox filter.

To link the City filter to the Country filter, another Source for the selected_country parameter was chosen. The
alternate source is the Country filter.

Once the filters are linked, users can select a country and then select a city (or cities) in the country of their choice.

Using this example, the report designer can now add a data table, chart, or other content in the dashboard that can be
driven by the filter he or she just created. Suppose the designer decides to add a pie chart to the dashboard. The pie
chart will display the percentage of sales per city.

In the Query Editor, the report designer creates a parameter, {City}, with an extended default value: NYC|Las Vegas.
The resulting pie chart displays values for New York City and Las Vegas. Under the Parameters tab associated with the
pie chart, the Source value for the City parameter is changed to the City filter.
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When the report is saved, users of the dashboard can see results for a country and multiple cities within that country.

Editing Filters

You can edit filters as needed. Follow the instructions below to edit filters:

1. Locate the filters pane at the top of the panes within the dashboard.

2. Located the different filters and the drop down menus next to them.

3. Select the filter you want to edit and select an alternative filter from the drop down menu.
The filter changes, causing the graphs and charts within the dashboard to change appropriately.

Linking Dashboard Filters to Analyzer Parameters

This process only applies to dashboards that include parameterized Analyzer reports. You must have an Analyzer
report with a query parameter in it in order to proceed.

The instructions below explain how to parameterize an Analyzer report.

1. In Analyzer, select a field in your report to which you want to link; then, right-click and choose Filter.

In the example below, data will be filtered by Territory.
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2. In the Filter dialog box, enter a name for the parameter in the Parameter Name text box and click the check box to
enable it.

3. Select the values you want associated with the parameter. Use the arrows to add values to the box on the right.

4. Click OK to exit the Filter dialog box.

5. Save your Analyzer report.

In the upper left corner of the report, you can see that a filter is in use. Click  (Edit) to edit your filter; click  to
delete the filter.
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6. Create a dashboard and drag the Analyzer report into a panel.

The name of the parameter appears in the lower portion of the dashboard under Parameters.

7. Add a filter to the dashboard based on the parameter you created in your Analyzer report.
The filter appears in the dashboard.

Dashboard Parameters
If you are placing a file, such as an .xaction or .prpt, inside a dashboard panel, it is possible that the author of the
file defined meaningful parameters for the content. If previously defined, the parameters and their associated default
values, appear under Parameters in the edit pane of the dashboard. In the example below, when the chart initially
rendered, it displayed a parameter called, "chart_type" with a default value called, "bar." A user can change the value of
the parameter to see the content rendered as a pie, line, or area chart.

Parameter names are "hard-coded," in the file; that means they cannot be changed. Neither can you change the
number of parameters associated with a file. When you create a chart using the Chart Designer, embed a URL into a
dashboard, or create a data table, you can change both the name and value of a parameter.
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Note:  In Windows, the URL Parameters have a maximum limit of 2,048 characters, minus the number of
characters in the acutal path.

Creating Chart or Data Table Parameters With the Query Editor

When you place a chart in a dashboard panel, you use the Query Editor to retrieve data from a database for display on
your chart or data table. If applicable, you can add conditions or constraints that filter the data so that the chart or data
table displays the information you want dashboard consumers to see.

Using parameters is critical if you plan on using dashboard filters or linking content in one dashboard panel to content
on another dashboard panel. For example, suppose you create a pie chart and you want to filter details associated
with an exploded pie slice in the adjoining data table as shown in the example below. In this instance, you must use a
parameter that allows the data table to update when a dashboard consumer clicks on a pie slice. Optionally, you can
parameterize the query condition so that the content is updated based on a user interaction, such as changing a filter
value.

To create a parameter, in the Value field, type the name of the parameter inside curly braces, as in {Parameter
Name}. In the example below, the designer created a parameter called, {TERRITORY}; the default value, or source,
for the parameter is, "NA" (North America). When a chart or data table renders, it displays data associated with North
America. Remember that this a default value. When you enclose a parameter name with curly braces, you are creating
a parameter query. That means, that users can change the query dynamically by replacing the default, "NA," with a
different territory acronym, (for example, EMEA), when the query runs.

You can define multiple default parameter values by adding a pipe (|) between the values, as in NA|EMEA|APAC.

Suppose a dashboard designer chooses to limit the data to North America (NA) exclusively? In this instance, he or she
would not include the curly braces around "NA," (as shown in the example below), and Default (value) is disabled. This
is an example of a static query.

Dynamic Dashboard Titles

While in Dashboard, each panel has the ability to show a title with current parameters.

1. Click on the edit (pencil) icon within the top toolbar.
The Edit Pane appears at the bottom of the screen
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2. Click on the report that has the parameters you are going to change. You will need to go through this process for
each report to which you want to add parameters.

3. Click on the Add Parameter button.

Placed parameter appears after the title.

4. Click Apply

5. Close the Edit Pane by clicking on the edit (pencil) icon.

The title will now show the parameters applied to it.

Using Content Linking to Create Interactive Dashboards
Depending on your needs, you can create a "static" dashboard, which contains content in each panel that is separate
but related. For example, you may provide users with a bar chart that contains total sales figures by region. Additionally,
you may provide a data table that displays sales details for each state in a specific region. You may also want to provide
sales data associated with each salesperson in a specific region. The content in your dashboard is useful to dashboard
consumers, but to make it more "interactive," you may want to consider using content linking.

The content linking features in dashboards allow you to associate (link) content in one dashboard panel to content on
another dashboard panel as long as query parameters have been defined. These features are particularly helpful for
drilling down or for dynamic filtering; for example, when dashboard consumers explode a single slice in a pie chart to
launch content in a data table associated with that pie slice. In this instance, dashboard consumers are moving from a
summary view to a detailed view interactively.

You can use content linking if your dashboard panel contains a data table, chart, .xaction, .prpt, and Analyzer report.

Content Linking and Query Parameters

Query parameters are required for content inside a dashboard panel to receive values used to filter data from a filter
control. They are also required when receiving values from content in other dashboard panels that are broadcasting
values associated with Content Linking. The way in which query parameters are defined is different depending on the
type of content you are placing inside your dashboard panels:
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If Then

You are defining parameters in the Analyzer... See Adding Query Parameters to Analyzer Reports

You are defining parameters in an Action Sequence
(.xaction)...

Refer to the section, "Content Linking in Dashboards," in
the Creating Action Sequences guide available from the
Pentaho InfoCenter.

You are defining parameters for a chart or data table... Use the Query Editor to define your parameterized query.
See Linking Charts and Data Tables and Linking Columns
in a Data Table to Content in other Dashboard Panels

Linking Charts and Data Tables

Below are general instructions for linking charts and data tables in a dashboard. This is just an example. You must
adjust the instructions when working with your own data.

1. Create a simple dashboard that contains a chart and a data table. At this point, none of the content has been linked
and you have a "static" dashboard.

Notice the pie chart in the example above. You want dashboard consumers to click a slice (NA, APAC, Japan,
EMEA) and have the data table on the right update with the values associated with that slice exclusively. For
example, if a report consumer clicks the EMEA slice, the data table will display values associated with EMEA and
nothing else. To get the correct filter display, you must first create a parameterized query that drives the content in
the data table.

2. Click the Edit Button to open up the Edit Pane at the bottom of the screen. Within the Objects pane, select the
report you want to parameterize.

Note:  Parameterizing a query, as described here, allows you to pass values dynamically and update the
chart based on events triggered by other elements of the dashboard such as a user selecting an item from a
filter control or following links defined in content associated with another panel in the dashboard.

3. Click on the {p} button next to the Title box.
The parameters will populate after the title within the Title box.

4. Click on the Parameters tab and ensure that the parameters name is linking to the correct Source.

5. Click Apply.

The new source for the parameter corresponds to the title of the dashboard panel that contains the chart as shown
in the example above. This new source will now drive the display in the data table.

6. Click on the Edit button (pencil icon) to exit the edit mode.
The filters will appear after the panel titles.

7. Save your dashboard. See Saving Your Dashboard.

When users click a pie slice or bar in a chart, the data table displays content associated with that specific pie slice or
bar. The currently applied filters appear after the title.

http://infocenter.pentaho.com
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Linking Columns in a Data Table to Content in other Dashboard Panels

The instructions that follow show you how to link a chart to a column in a data table. You must adjust the instructions
when working with your own data.

1. Create a simple dashboard that contains a data table and a bar chart. At this point, none of the content has been
linked and you have a "static" dashboard.

Notice the data table in the example above. You want dashboard consumers to click on a product in the Product
Line column and have the bar chart update with information about sales by territory for that specific product line.

2. Add a parameterized condition to the query for the bar chart by specifying a parameter name in curly braces in the
Value text box; then, provide a default value for that parameter in the Default text box. In the example below, a
parameter called Productline with a default value of Classic Cars has been created.



 | Using Pentaho Dashboard Designer | 63

3. In the Chart Designer, set the data definitions for the series, category and values columns associated with your bar
chart and click OK.

4. Under General Settings, select the data table and click the Content Linking tab. Enable content linking on
the column in your data table that will filter content in your chart. Each of the columns in a data table are able to
broadcast values to other dashboard components.

5. Under General Settings, select the chart and click the Parameters tab. Click the down arrow, in the Source text
box to display another source for the parameter you created. In the example below, notice that Order Details -
Product Line , (this is the name of the dashboard panel that contains the data table), can now be selected as a
source for the Productline parameter.

6. Save your dashboard.

7. In the data table, select an item in the column that has content linking enabled.
The content in the chart updates in response to the item that was clicked in the data table.

In the example below, the Product Line column was enabled for content linking.
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Creating Content to Content Links in an Analyzer Report

Below are general instructions for creating content links in an Analyzer report, (inside a dashboard), that can be used
to drive the parameter values of content in other dashboard panels. You must adjust the instructions when working with
your own data.

1. Create a simple dashboard that contains an Analyzer Report and a data table. At this point, none of the content has
been linked and you have a "static" dashboard.
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In the example above, when content linking is achieved, the list of territories (APAC, EMEA, Japan, and NA) will
become hyperlinks that, when clicked, will update customer details data table. To get the correct filter display, a
parameterized query that drives the content in the data table must be created.

2. Add a parameterized condition to the query for the data table by specifying a parameter name in curly braces in
the Valuetext box; then, provide a default value for that parameter in the Default text box. In the example below, a
parameter called TERRITORY with a default value of NA has been created.

Note:  Parameterizing a query, as described here, allows you to pass values dynamically and update the
chart based on events triggered by other elements of the dashboard such as a user selecting an item from a
filter control or following links defined in content associated with another panel in the dashboard.

Under General Settings, click the data table and examine its available parameters. In the example below, there is
an available parameter called TERRITORY with a default source value of NA (North America). A drop-down arrow
in the Source text box indicates that there are additional values to control the available parameter. In this example,
there are no additional source values that control the TERRITORY parameter.

3. Under General Settings, select the Analyzer report. Click the Content Linking tab then click the check box next to
the field/column name you want enabled for content linking. Click Apply.

In the Analyzer report, the values under the Territory become hyperlinks.

4. Under General Settings, select the data table and examine its available parameters. Notice that there is a drop-
down arrow in the Source text box. Click the down arrow to display and select a new source value for the available
parameter. Click Apply.

5. Save your dashboard.
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In the example below, content linking was applied. When users click on a territory hyperlink in the Analyzer report, the
data table updates and displays customer-related details associated with that specific territory exclusively.

Linking an Analyzer Chart to a Report

You can create content-to-content links between an Analyzer chart and any other parameterized report such as a
Report Designer report, a data table, or another Analyzer report.

Below are general instructions for linking an Analyzer chart to a report. You must adjust the instructions when working
with your own data.

1. Create a simple dashboard that contains an Analyzer chart and a parameterized report. The example above displays
an Analyzer chart and an Analyzer Report displayed as a table view. At this point, none of the content has been
linked and you have a "static" dashboard.

Hypothetically, if you want users to be able to click on a bar in the bar chart and update the Analyzer table view,
the table must contain at least one parameter. In the example below, there are two parameters, (LINE and
TERRITORY), associated with the Analyzer table.
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2. Under General Settings, select the Analyzer chart. Click the Content Linking tab then click the check box (or
check boxes) next to the field/column name you want enabled for content linking. Click Apply.

3. Under General Settings, select the Analyzer Report (table view) and click the Parameters tab. Click the down arrow,
in the Source text box to display another source for the parameters you created. In the example below, notice that
Sales by Line, (this is the name of the dashboard panel that contains the chart), can now be selected as a source
for both the TERRITORY and LINE parameters.

4. Save your dashboard. See Saving Your Dashboard.

In this example, content linking is applied when users click on a bar in the bar chart. The data table updates and
displays sales details for a product line in a specific territory.
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Linking an Action Sequence Parameter to Content in other Dashboard Panels

To complete this task you must have an action sequence (.xaction) that contains at least one parameter. For
information about defining parameters in an action sequence see Creating Action Sequences.

Below are general instructions for allowing an Action Sequence parameter to drive the filter associated with content in
another dashboard panel. You must adjust the instructions when working with your own data.

1. Create a simple dashboard that contains an action sequence file and a data table. At this point, none of the content
has been linked and you have a "static" dashboard.

Notice the chart (action sequence file) in the example above. You want dashboard consumers to click on a territory
(APAC, EMEA, etc.), bar and have the data table update with information about that territory specifically.

2. Under General Settings, select the action sequence file and click Content Linking. If parameters have been
defined in the action sequence, they will appear as values to be enabled for content linking. Parameters are hard-
coded in the action sequence and cannot be changed.



 | Using Pentaho Dashboard Designer | 69

3. Add a parameterized condition to the query for the data table by specifying a parameter name in curly braces in the
Value text box; then, provide a default value for that parameter in the Default text box.

Note:  Parameterizing a query, as described here, allows you to pass values dynamically and update the
chart based on events triggered by other elements of the dashboard such as a user selecting an item from a
filter control or following links defined in content associated with another panel in the dashboard.

Under General Settings, click the data table and examine its available parameters. In the example below, there is
an available parameter called TERRITORY with a default source value of EMEA. A drop-down arrow in the Source
text box indicates that there is an additional value to control the available parameter. The value comes from the
parameter in the action sequence.

4. Save your dashboard. See Saving Your Dashboard.

5. In the action sequence file click on an object such as a bar as shown in the example above.
The content in the data table updates in response to the object that was clicked in the action sequence.

Controlling a Dashboard Parameter From a PRPT Hyperlink

You must have a report (.prpt) that contains a hyperlink before you can complete this task. See the Report Designer
User Guide, (available in the Pentaho InfoCenter), for instructions about adding hyperlinks to a report.

The instructions that follow show you how a link inside a Report Designer report (.prpt) can drive a parameter in content
on another dashboard panel. You must adjust the instructions when working with your own data.

1. Create a simple dashboard that contains a .prpt report and a data table. At this point, none of the content has been
linked and you have a "static" dashboard.
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Notice the report (.prpt) in the example above. You want dashboard consumers to click on a territory (APAC, EMEA,
etc.), hyperlink and have the data table update with information about that territory specifically.

2. Under General Settings, select the report (.prpt) and click the Content Linking tab. Click the checkbox next to the
field you want used for content linking.

3. Add a parameterized condition to the query for the data table by specifying a parameter name in curly braces in
the Valuetext box; then, provide a default value for that parameter in the Default text box. In the example below, a
parameter called TERRITORY with a default value of NA has been created.

Note:  Parameterizing a query, as described here, allows you to pass values dynamically and update the
data table based on events triggered by other elements of the dashboard such as a user selecting an item
from a filter control or following links defined in content associated with another panel in the dashboard.

4. Under General Settings, select the data table and click the Content Linking tab. Click the drop-down arrow, in
the Source text box to display another source for the parameter you created. In the example below, notice that
Product Line Share by Territory - Territory , (this is the name of the dashboard panel that contains the .prpt), is
now selected as a source for the Territory parameter.

5. Save your dashboard. See Saving Your Dashboard.
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When content linking is achieved, the data table updates when a link in the report (.prpt) is clicked as shown in the
example below.

Adding Content to a Dashboard Using Drag-and-Drop
Follow the instructions below to add an existing chart, table, or file to your dashboard panels using the drag-and-drop
feature.

1. Create a new dashboard. See Creating a New Dashboard for specific instructions.

2. In the left pane of the Pentaho User Console, under Files, locate to the content (chart, table, or file) you want added
to your dashboard.

3. Click and drag the content into a blank panel on your dashboard. You will see the "title" of the content as you move it
around the dashboard. Notice that the title background is red; it turns green when you find a panel where the content
can be dropped.

Repeat steps 2 and 3 until your dashboard contains all the content you want to display. To swap content from one
panel to another, click the title bar of the panel that contains the content you want moved and drag it over the panel
you want swapped. You will see the swap icon as you are moving the content.

If you are working with an existing dashboard, you can perform steps 2 and 3 steps; however, a warning message
appears when you try to place content in a panel that already contains content. The new content will override the
existing content.

4. Save your dashboard.

Adjusting Whitespace in Dashboard Panels
Sometimes you must adjust the whitespace in dashboard panels, (or the filter panel), so that content appears correctly.
Follow the instructions below to adjust whitespace.

1. Open an existing dashboard.

2. In the lower pane, click General Settings and then click the Properties tab.

3. Click Resize Panels.
The whitespace between the dashboard panels turns blue.

4. Adjust the panel size by clicking and holding the left mouse button down as you move the blue lines (whitespace)
around. Release the mouse button when you are satisfied with the positioning of the panel.
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5. Click Close in the lower right corner of the dashboard to exit resize layout mode.

6. Examine the dashboard contents to make sure they are placed correctly. You can return to the resize layout mode if
you need to make additional changes.

7. Save your dashboard.

Printing Dashboards
You can not print Pentaho Dashboards unless this capability has been enabled by your administrator.

When you print a dashboard, the printed output replicates how the dashboard appears on your screen.

1. Maximize the dashboard to fill the entire screen area and arrange the components according to how you want the
printed output to appear.

2. From the dashboard toolbar, click the Print button.
The Print Settings window appears. This will be the output format.

3. Specify output options, such as paper size and orientation, and click the Print button.
The browser Print dialogue box appears.

4. Specify the options you want to use, including the same options you specified in the Print Settings window.

For example, if you specified landscape orientation in Print Settings, also specify landscape orientation in the
browser Print dialogue box. Print Settings influence the output and do not influence the Print dialogue box.

The dashboard prints.

Printing a Dashboard Panel
If Pentaho Dashboard printing is enabled by the administrator, you can print an image of what appears in a single
dashboard panel. You can print the panel if it contains a Pentaho report, dashboard chart, or dashboard data table.

The printed output replicates the display of the panel on your screen. If you print a dashboard panel that contains an
Analyzer Report, a full PDF copy of the report will be generated.

1. From the dashboard toolbar, click the Edit button.
The dashboard state changes to edit mode.

2. Go to the Objects pane, at the bottom of the screen, and click General Settings.

3. Click the Properties tab and check Allow content printing.
A Print button appears in the upper right-hand corner of the dashboard panel.

4. Click the Print button. See Printing Dashboards on page 72 for more information about printing.
What appears in the dashboard panel prints.
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Setting the Refresh Interval
The content in your dashboard may need to be refreshed periodically if users are examining real-time data. You can set
refresh intervals for individual panels on your dashboard or for the entire dashboard.

To set the refresh interval for individual panels in the dashboard, click the edit button and the select the panel that
contains the content you want refreshed within the Objects panel . Under Refresh Interval (sec) enter the interval time
in seconds and click Apply.

If you want the entire dashboard to refresh, click the Prompts tab in the dashboard and set your refresh interval.



 | Using Pentaho Mobile | 74

Using Pentaho Mobile

Get immediate access to powerful business analysis at any time with Pentaho Mobile, an innovative application built
specifically for the Apple iPad. Touch navigation technology enables you to access content with the tap of a finger.

Setting Up Mobile Access
To get access to Pentaho Mobile, you must

1. Ensure that an administrator installs the Pentaho Mobile license key along with the Pentaho license keys for
Pentaho Business Analytics Enterprise Edition. See the Pentaho Business Analytics Administrator's Guide for more
information.

2. Have an Internet connection
3. Obtain the Pentaho server IP address or host name from your administrator and enter it into the iPad Safari web

browser. For example,http://<hostname>:8080.

Getting Started with Pentaho Mobile
Once you have access to Pentaho Mobile, log in with the same user name and password you use for the Pentaho
User Console. Logging in enables you to view and create reports. If you have permission, you can also edit Pentaho
Analyzer reports.

After accessing Pentaho Mobile, a dialog box appears. If you choose to toggle Yes for the Remember me on this
device prompt, the prompt does not appear the next time you access Pentaho Mobile from that iPad. You can change
this by going to Settings.

Creating a Shortcut Using Safari

When you view Pentaho Mobile in the Safari browser, the browser toolbars take up some of the viewing area. To obtain
the maximum viewing area and to launch Pentaho Mobile from your iPad Home screen, create a shortcut.

1. Open Pentaho Mobile.

2. Tap the Share  button.

3. Tap Add to Home Screen.

4. Type in an alternate name, or keep the name PentahoMobile, and tap the Add button.
A shortcut appears on the iPad Home screen. The next time you launch from the shortcut, you will have a
maximized viewing area.

Working with the Home Screen

Before you start using Pentaho Mobile, take a quick tour of the interface and basic navigation.
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The Home screen is divided into three panels.

Recent This panel displays a list of the last ten files you have
opened with Pentaho Mobile and the Pentaho User
Console. You can change the maximum number of file
names that appear by going to Settings.

Favorites This panel displays a list of the files marked as favorites.

Opened Files This panel displays a list of files that are currently open.

Using the buttons on the Home screen, you can navigate to and select files that contain the content you want to view.
You can also perform other actions.

Browse Files Browse files saved on the Pentaho Analysis Server.

Create New Content Create a new Pentaho Analyzer report.

Startup Screen Open the file you have selected to load when Pentaho
Mobile launches. If you want to edit this selection, tap
Settings.

Settings Specify options for configuring Pentaho Mobile.

Refresh All Refresh the Recents, Favorites, and Open Files lists.

Help Access the Pentaho Mobile documentation.

There are three buttons at the bottom of the screen.

Home Instantly navigate to the Home screen.

New This button displays if you have permission to create new
Analyzer reports.

Open View a list of open files. The number of open files appears
as a badge on the icon. You can also use this button to
close files by tapping the X that is located after the file
name. If no files are open, the Browse option appears so
you can select a file to open.
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Navigating Files

Browsing Files

To select a file and load its viewable content, tap the Browse Files  button. Then tap either All, Favorites, or Recent
and select the file that has the content you want to view. The file loads in your screen.

Moving Between Files

If you have several files open, you can navigate between them by tapping Open at the bottom of the screen. All of the
open files appear and you can select the one you want to view.

Closing Files

To close a file, tap the X in the Open Files list.

Creating and Removing Favorites

Marking a file as a favorite makes it easier to find. Favorites appear on the Home screen and in the Favorites tab when
you tap on Browse.

Creating Favorites

To mark a file as a favorite, tap the star. The star turns yellow, indicating it is a favorite.

Removing Favorites

To remove the favorite status from a file, tap the yellow star. The star is no longer yellow, indicating that the file is not a
favorite.

Settings

If you want to change your settings, tap the Settings  button. You will find these options while in Settings.

Startup Screen

Change the Startup Screen to load with a file instead of the default Home screen. To load a file on startup, tap Select
a file, navigate to the correct file, and select it. The selected file appears in the Startup Screen list with a highlighted
option button. If you want to make the Pentaho Home screen the startup screen again, tap the Pentaho Default Home
option button.

Recent Files

To change the number of recent files tap the plus or minus next to Keep The Last. You can also tap Clear All Recent
Files.

Clearing Favorites and Settings

To clear favorites and settings for Pentaho Mobile:

• Tap Clear All Favorites to clear your favorites list.
• Tap Reset All Settings to reset all of your settings, including local storage, such as saved password settings and

dialog preferences. Reset All Settings also clears the Recents list in the Pentaho User Console.

Help

This content appears when you tap Help.

Pentaho Mobile Information

Tap About Pentaho Mobile for product information, such as version number.
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Password Protection

To specify whether or not your password is saved, tap Remember me on this device and toggle the switch to Yes or
No. You will automatically be signed in when you start Pentaho Mobile.

Logout

Tap Logout to end your session of Pentaho Mobile.

Working with Pentaho Mobile Tools
You can view previously created files using Pentaho Mobile. You may feel familiar with the experience of Pentaho
Mobile if you have used the Pentaho User Console. If you have not used the Pentaho User Console, you can view the
Pentaho User Console Guide to familiarize yourself with its capabilities. The Pentaho User Console Guide is available
on the Pentaho InfoCenter, which is best viewed from your desktop web browser.

Pentaho Mobile responds to the standard iOS device gestures and changes in orientation.

Using the Overlay Toolbar

The Overlay Toolbar is a content-driven toolbar that allows you to easily perform common actions. For all content, you
can tap Overlay Toolbar  to create Favorites, Refresh content, or Close content. For Analyzer Reports, you can
also Save and Save As if your administrator has given you permission.

Mobile Reports

You can view reports that were created with the desktop version of Pentaho Interactive Reporting or Pentaho Report
Designer. If you need more information, see the Pentaho User Console Guide and the Pentaho Report Designer User
Guide.

http://infocenter.pentaho.com/help/index.jsp
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Mobile Analyzer

You can view and edit Pentaho Analyzer reports using Pentaho Mobile. Previously created content opens in view mode,
with the design panels closed. If you would like to edit a report, you can use the icons on the toolbar to access the
design panels.

If you need more information about how to view and edit Pentaho Analyzer Reports, see the Pentaho User Console
Guide.

Mobile Dashboards
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You can view dashboards created with the Pentaho User Console Dashboard Designer. You may want to optimize
your dashboards for the mobile environment by selecting layout templates that are better for smaller screen sizes and
avoiding Flash charts since the iPad does not support Flash. If you choose to view a Flash chart on Pentaho Mobile, it
converts to a static image.

If you need more information about how to create Pentaho Dashboards, see the Pentaho User Console Guide.



 | Administration and Advanced User Topics | 80

Administration and Advanced User Topics

The tasks and topics in the sections that follow are targeted to administrators and advanced users.

Customizing the Pentaho User Console
It is possible to customize the Pentaho User Console. The Pentaho User Console is a Web interface for the Pentaho
BA Server. It allows you an easy way to interact with Pentaho Reporting and Analysis. By editing its configuration files,
graphics, and CSS3 style sheets manually, you can customize the look and feel of the Pentaho User Console.

Refer to the Customizing Pentaho Business Analytics document if you need more information for customizing the
Pentaho User Console.

Customizing Pentaho Business Analytics has more information on how to:

• Replace or Translate Message Bundles
• Customize the Quick Launch Page
• Replace the Default Icon Set
• Change the Default Logo
• Use Firebug to Test CSS Changes

Adding a Data Source in the Pentaho User Console
The Data Sources feature allows you to connect to your data so that the data can be used to create reports, (such as
Interactive Reports, Analyzer Reports, and Dashboards), in the Pentaho User Console.

Using the Data Source Wizard, you can quickly add, edit, and delete CSV File, SQL Query, and Database Table(s)
data sources in the Pentaho User Console.

Below is a quick description of each data source type:

Data Source Type Description

CSV File Data originating in a CSV file is extracted and staged in
a database table on the Pentaho BA Server. A default
Pentaho Metadata (Reporting) Model and a Mondrian
(OLAP) Schema are generated for use in Interactive
Report, Dashboard, and Analyzer.

SQL Query A SQL query written against a relational database is used
to establish the context of the data source. Data available
for report creation is confined to the scope of the data
source’s query. A default Pentaho Metadata (Reporting)
Model and a Mondrian (OLAP) Schema are generated for
use in Interactive Report, Dashboard, and Analyzer.

Database Table(s) Reporting Only Data originates in a one or more relational database
tables that is often operational or transactional in nature.
Using the Data Source Wizard, database tables can
be selected and joined. A default Pentaho Metadata
(Reporting) Model is generated for use in Interactive
Report and Dashboard only.

Database Table(s) Reporting and Analysis Data originates in one or more relational database tables
arranged in a star schema with a single fact table. Using
the Data Source Wizard, multiple dimension tables can
be selected and joined to the single fact table. A single
table containing both fact and dimensional information can
also be used for this data source type. A default Pentaho
Metadata (Reporting) Model and a Mondrian (OLAP)
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Data Source Type Description

Schema are generated for use in Interactive Report,
Dashboard, and Analyzer.

You can restrict access to a data source by individual user or user role; by default, authenticated users are limited
to view-only permissions. (See "Assigning Data Source Permissions for the Pentaho User Console" in the Pentaho
Security Guide for more information.) This means that they are limited to selecting a data source from a list of available
options.

Note:  Non-administrative users of the Pentaho User Console do not see icons or buttons associated with
adding, editing, or deleting a data source.

The Data Source Wizard, which allows you to set up access to a relational data source or CSV data source in the
Pentaho User Console, is available in the following instances:

• When you click the New Data Source button on the Pentaho User Console Quick Launch page
• When you select File -> New -> Data Source in the Pentaho User Console menu bar
• When you select File -> Manage -> Data Sources from the Pentaho User Console menu bar and click the Add Icon
• When you click the Add Icon in the Select Data Source dialog box when creating an Interactive Report.
• When you click the Add Icon in the Select Data Source dialog box when creating a chart in a Dashboard
• When you click the Add Icon in the Select Data Source dialog box when creating a data table in a Dashboard
• When you click Create New Data Source when creating a new Analyzer report

Note:  Data Source Wizard is intended for prototyping or as a starting point for Pentaho Analysis and Pentaho
Metadata models used with Interactive Reporting reports, Analyzer reports, and dashboards. We recommend
that these models be re-created or edited with Schema Workbench or Metadata Editor to ensure query
performance and to take advantage of enhanced functionality when used in production environments.

Note:  The following characters are not allowed in Data Source Wizard source names: $ < > ? &; # % ^ * ( ) !
~ : ; [ ] { } |

Connecting to Your Database

If you are creating a SQL Query data source or Database Tables data source, you must first connect to the database
that contains data you want to access, (if a database connection does not already exist). Existing database connections
appear in a list under Connection in the Data Source Wizard.

Follow the instructions below to connect to a database:

1. In the Pentaho User Console launch page click Create New to open the Data Source Wizard.

2. Under Data Source Name type a name that for the data source that makes it easily recognizable.

3. Under Source Type, select your data source type, either SQL Query or Database Table(s).

4.
If not already configured, click  (Add) to define a connection to the database that contains the content you want to
access. The Database Connection dialog box appears.
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Important:  Click the Adding Databases hyperlink if you need help connecting to your database.

5. In the Connection Name text box, enter an easy-to-remember name that identifies the data you are accessing.

6. Select a Database Type from the list.

Text fields for required settings associated with your connection type appear under Settings on the right.

7. Enter the appropriate connection information for your database type.

See the Compatibility Matrix: Supported Components  found in any install guide for information about data sources
and JDBC drivers.

8. In the Database Connection dialog box, click Test to test your connection and click OK.
A success message appears if your settings are correct. The connection name appears in the list.

Creating a SQL Query in the Pentaho User Console

Follow the instructions below to create a SQL Query data source. In addition to allowing you to connect to your
database (using JDBC), you must also enter a SQL statement that defines the "scope, "(similar to a database view), of
your data source.

Note:  In the context of the Pentaho User console, a SQL Query "data source" is a combination of a connection
plus a query. Pentaho recommends that you use the Pentaho Metadata Editor to create SQL Query data
sources for a production environment.

You can customize how columns are presented to users who are building queries against the new data source; for
example, you can define "friendly" column names and select options that define how data is aggregated (sum, min.,
max., etc.), and more.

Once you create the data source, it is available to users of the Interactive Reports, Analyzer, and Dashboards.

You must be logged on to the Pentaho User Console as an administrator to follow the instructions below. Additionally,
your database must be up and running in order for you to complete the steps required in the Data Source Wizard.

1. In the Data Source Wizard, type a name for the new data source in the Data Source Name field.

Note:  The name of the data source is important because it becomes the name of the data source displayed
in Analyzer, Interactive Report, and Dashboards.
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2. Under Source Type, select SQL Query as your data source type.

3. Select a database connection from the list. under Connection.

4. Under SQL Query, enter your SQL Query. Click Preview to ensure that your query returns data.

5. Click Close to exit the Preview window.

6. Click Finish.
In the background, after you click Finish, a default metadata model is generated based on the query for use
in Analyzer, Interactive Report, and Dashboards. See Editing a Data Source Connection for instructions about
changing connection details.

Creating a CSV Data Source in the Pentaho User Console

Follow the instructions below to create a CSV-based data source. For testing purposes, you can save an Excel
spreadsheet as a CSV file.

1. In the Data Source Wizard, type a name that identifies your new data source in the Data Source Name field.

2. Under Source Type select CSV File from the list to define a CSV file as your data source and click Next.

3. Click Import to open the Import File dialog box.

4. Click Browse to search for your CSV file; click Import when you locate the file.
The Import File dialog box closes and the CSV file is uploaded to the BA Server. You can click Cancel, if necessary,
and select different file.

Note:  Notice that a preview of the contents of your file appears in the lower portion of the wizard page. If
items are not aligning correctly, it is because you must specify your delimiter and enclosure types. Go on to
the next step.

5. Specify the delimiter and enclosure types. Enable First row is header if the first row of your CSV file is a heading
for columns in the file.
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Important:  You must make selections under Delimiter and Enclosure for the Metadata table to build
correctly. In the example line, 1,4,5,02/12/77,"String Value" the commas are delimiters and the
quotation marks around "String Value" is the enclosure.

The File Preview window displays the first few lines of your CSV file based on the selections you made for
specifying the delimiter, enclosure, and header. Once the columns align correctly in the preview you will know that
the delimiter and enclosure have been set correctly.

6. Click Next to display more details about the columns in your source file and to edit staging-related settings.

Note:  Notice that all columns are enabled in this step. Click Deselect All to disable all columns. You can
then select the columns that require formatting individually. Click Select All to enable all columns again, if
necessary.

7. If applicable, change the  Name and Type values. Use the drop-down list to display format options for dates and
numeric values. Formats are auto-detected based on the contents of your data source; however, if you see a format
option that is not correct, enter it manually in the appropriate Source Format text box.

Length indicates the maximum number of characters allowed in a field. Precision is the number of digits after a
decimal point. Drop-down lists are not enabled for certain data types such as the String data type.
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Important:  Boolean values are rendered as "true" or "false."

8. Click Show File Contents to see a sample of the data in your source file. Click OK to return to staging and make
changes if necessary.

9. Click Finish when you have completed your configuration and formatting tasks.
A success message appears indicating the number of rows being loaded into the database and that a default
metadata model was created. Enable Keep default model to use the default model or click Customize model now
to customize the model.

The data in your CSV file is extracted and staged in a database table. Your new data source is now available for use
in Analyzer, Interactive Report, Ad Hoc Report, and Dashboards. To refine the data and make it more accessible to
users of you must use the Data Source Modeler. The model can be further customized to adjust field names, formatting,
aggregation types, and dimensional hierarchies (for Pentaho Analysis). See Editing a Data Source in the Pentaho User
Console.

Increasing the CSV File Upload Limit

Follow the instructions below if you need to increase the size of the upload limit associated with CSV files.

1. Go to ...\biserver-ee\pentaho-solutions\system and open the pentaho.xml file.

2. Edit the XML as needed; (sizes are measured in bytes):

<file-upload-defaults>
      <relative-path>/system/metadata/csvfiles/</relative-path>

      <!-- max-file-limit is the maximum file size, in bytes, to allow to be
 uploaded to the server -->
      <max-file-limit>10000000</max-file-limit>

      <!-- max-folder-limit is the maximum combined size of all files in the upload
 folder, in bytes. -->
      <max-folder-limit>500000000</max-folder-limit>

</file-upload-defaults>

3. Save your changes to the file.
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4. In the Pentaho User Console, go to Tools -> Refresh System Settings to ensure that the change is implemented.

5. Restart the Pentaho User Console.

Changing the Staging Database

Hibernate is the default staging database for CSV files. Follow the instructions below if you want to change the staging
database.

1. Go to ...\pentaho-solutions\system\data-access and open settings.xml.

2. Edit the settings.xml file as needed. The default value is shown in the sample below.

<!-- settings for Agile Data Access -->
<data-access-staging-jndi>Hibernate</data-access-staging-jndi>

Note:  This value can be a JNDI name or the name of a Pentaho Database Connection.

3. Save your changes to the settings.xml file.

4. Restart the Pentaho User Console.

Creating Database Table(s) Data Sources

The Database Table(s) data source type allows you to create a reporting and/or analysis data source against one or
more relational database tables. This data source type is useful for a broad range of use cases including reporting
directly against an operational data store (ODS) or creating a connection for OLAP Analysis against a star schema.

When you create a Database Table(s) data source, you are presented with two options: Reporting Only or Reporting
and Analysis. The choice you make depends on the schema structure of the database tables you are accessing and
the Pentaho User Console tools being used.

Reporting Only

If you are accessing data in a relational database that is operational or transactional in nature, or which does not
contain a star schema, choose Reporting Only. This option creates a data source that can be used in Interactive
Report and Dashboard Designer. When you select the Reporting Only option, a Metadata Model is automatically
generated and can be refined in the Modeler interface or further extended using Pentaho Metadata Editor.

In a production environment, users of the Pentaho User Console get access to data for creating interactive reports and
building dashboards from metadata models provided by an administrator. Using Pentaho Metadata Editor (PME), you
can restrict what data a user can access down to a table, column, or row.

The default metadata models created when adding new data sources in the Pentaho can be opened in Pentaho
Metadata Editor for further customization. For more information, refer to the Pentaho Metadata Editor Guide available in
the Pentaho InfoCenter.

Important:  If you extend a metadata model in PME, you can no longer use the Modeler to edit the model in the
Pentaho User Console.

Reporting and Analysis

If you are accessing a relational database that contains tables arranged in a star schema, (tables are separated into
dimensions related to a single fact-table, such as a data warehouse), choose Reporting and Analysis. Additionally,
you can create a Reporting and Analysis data source using a single table where the table acts as the single fact
table and also contains dimensional information. This option creates a data source that can be used in Analyzer,
Interactive Reports, and Dashboards. In this instance, a Mondrian Schema and Metadata Model are generated and
can be refined in the Modeler interface or further extended using Schema Workbench and Pentaho Metadata Editor,
respectively.

Important:  Metadata Models and Mondrian Schemas that have been extended in Pentaho Metadata Editor and
Schema Workbench can no longer be edited in the Modeler.

Creating a Database Table Data Source (Reporting Only)

Follow the instructions below to create a Database Table(s) data source for reporting.
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Note:  You must be logged on to the Pentaho User Console as an administrator to follow the instructions below.
Additionally, your database must be up and running in order for you to complete the steps required in the Data
Source Wizard.

1. In the Data Source Wizard, type a name for the new data source in the Data Source Name field.

Note:  The name of the data source is important because it becomes the name of the data source displayed
in Analyzer, Interactive Report, and Dashboard Designer.

2. Under Source Type, select Database Table(s) as your Source Type.

3. Under Connection, select a database connection.

Note:  The database connection allows you to access the database on which the data resides. If you do not
have a database connection listed, you must create one. See Connecting to Your Database for instructions.

4. Under Create data source for click, Reporting only and click Next.
A list of available tables that were retrieved from your database appear.

5.
Under Available Tables, select a table and click  (Add) to move the table under Selected Tables. If you add

a table you decide not to use, click  (Remove) to remove the table from the list of available tables. To choose
multiple tables press the <CTRL> key down as you make your selections; click Next when you are done.

Note:  While you can create a data source from a single table, the more common scenario is that you will
select multiple tables which must then be joined.

6. To define the relationship between tables, click the down arrow under Left Table and select a table from the list.
Select the appropriate table under Right Table.

Note:  The only join condition allowed in the Data Source Wizard is an inner join; references to left table and
right table are not associated with other types of join conditions.

7. Click Create Join to define the inner join between each table. All tables must have a join condition; orphan tables
are not allowed.
The join relationship for each table is displayed in the lower portion of the dialog box. Click Delete Join to delete a
selected join.

8. Click Finish.
In the background, after you click Finish, a default metadata model is generated for use in Interactive Report and
Dashboards. You can choose to keep the default model or customize the model. To customize the model, see
Editing a Reporting Data Source for instructions.

Creating a Database Table Data Source (Reporting and Analysis)

Follow the instructions below to create a Database Table(s) data source for reporting and analysis.

Note:  You must be logged on to the Pentaho User Console as an administrator to follow the instructions below.
Additionally, your database must be up and running in order for you to complete the steps required in the Data
Source Wizard.

1. In the Data Source Wizard, type a name for the new data source in the Data Source Name field.

Note:  The name of the data source is important because it becomes the name of the data source displayed
in Analyzer, Interactive Report, and Dashboard Designer.

2. Under Source Type, select Database Table(s) as your data source type.

3. Under Connection, select a database connection.

Note:  The database connection allows you to access the database on which the data resides. If you do not
have a database connection listed, you must create one. See Connecting to Your Database for instructions.

4. Under Create data source for click, Reporting and Analysis (Requires Star Schema); click Next.
A list of available tables appear.

5. Under Available Tables, select a table and click small green arrow (Add) to move the table under Selected Tables.
If you add a table you decide not to use, click small green arrow (Remove) to remove the table from the list of
available tables. To choose multiple tables press the <CTRL> key down as you make your selections.
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Note:  You can create a data source from one Fact and multiple Dimension tables or from a single Fact table
with no Dimension tables.

6. In the lower right portion of the dialog box, choose your Fact Table from the list and click Next.

7. To define the relationship between fact table and the dimension tables, select a dimension table from the list under
Right Table.

Note:  Because there is only one fact table it is only table available under Left Table. All dimension tables
must join the fact table. The only join condition allowed in the Data Source Wizard is an inner join.

8. Click Create Join to define the inner join between the fact and dimension table(s). All dimension tables must have a
join condition to the fact table; orphan tables are not allowed.
The join relationship for each table is shown in the lower portion of the dialog box. Click Delete Join to delete a
selected join.

9. Click Finish.
In the background, after you click Finish, default models are generated for use in Interactive Report, Analyzer, and
Dashboard Designer. You can choose to keep the default models or customize the models. To customize, (edit the
default models), see Editing a Reporting Data Source and Editing an Analysis Data Source for instructions.

Where Metadata Models and Mondrian Schemas are Stored

All generated Metadata Models and Mondrian Schemas are stored in the following location, \pentaho-solutions
\admin\resources\metadata.

Important:  Pentaho recommends that you do not change the location where models and schemas are stored.

Using the Modeler to Customize a Data Source

The Data Source Modeler displays if you choose to customize your model in the last step of the Data Source Wizard
or if you edit the data source later. The Modeler allows you to design reporting metadata models and analysis (OLAP)
models on the fly. The Modeler also allows you to refine and organize your metadata so that it is more accessible to
report users.

You can edit a data source in Interactive Report, Pentaho Analyzer, Dashboard Designer, and Data Source Manager.
If you are editing a data source while using Interactive Report, select the data source you want to edit from the list
of available data sources and click Edit. If you are creating a chart or data table in a dashboard, select the data

source you want to edit from the list and click  (Edit). If you have created an Analyzer report, click  (Edit) in the
upper right corner next to Available Fields. You can also edit a data source by navigating to File -> Manage -> Data
Sources in the Pentaho User Console menu bar and opening the Select Data Source dialog box.

Customizing a Reporting Data Source

The Modeler allows you to further refine your reporting data source. For example, you can add new categories and
fields, rename categories and fields, assign aggregation type, and define formatting for fields, or clear the model and
start over.
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Follow the instructions below to edit a reporting data source:

1. In the  Modeler, examine your data.

A representation of the physical tables and columns is displayed on the far left portion of the dialog box (under
Available). In the center of the dialog box is the default metadata model. The default, auto-generated metadata
model, is organized into categories and fields that mirror the physical tables and columns. In the far right portion of
the dialog box are the properties associated with a category or field you have selected.

2. Click and drag a category or field into the position you want it to be displayed to users.

Use the Modeler toolbar controls to create new categories and fields. Use the up/down arrows to reorder the
categories and fields in a way that makes sense to the consumers of the data. Delete unnecessary fields by clicking

 (Delete).

Change the properties, (Display Name, Default Aggregation, and Format), associated with a selected field as
needed.

Note:  Click  (Clear All) to clear an existing model. Click and drag tables into the Model view to create a
new model. You can mix and match fields that derived from different tables, even add fields more than once
to different categories.

Note:  If necessary, click  (Edit Source) in the modeler to make changes to Database table selections and
joins, edit a SQL query, or CSV flat file (delimiter, enclosure, or header). Click Finish to save your updates. If
you disable columns that were previously enabled, a prompt appears in the modeler indicating that the data
has been deleted. You must adjust the data in the modeler before proceeding.

3. Click OK to update the data source.

The updated data source is now available to users.

Customizing an Analysis Data Source

The Modeler allows you to further refine your analysis-based data source. For example, you can change the field
display names, create hierarchies and levels, set an aggregation type, and change formatting.

Note:  If you have created a CSV, SQL Query, or a Database Table(s) Reporting and Analysis data source,
you can make changes to both the Reporting metadata model and to the Analysis model (Mondrian Schema),
independently.

Note:  While users are able to create interactive reports, Analyzer reports, and dashboards using the default
model that is generated when you first create a data source, the structure of the default Analysis model is "flat."
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For example, the auto-model process creates a dimension for every table and a hierarchy plus level combination
for all columns in that table. In most instances you will want to refine the default model to make the data more
easily understandable to your users.

Follow the instructions below to edit an analysis data source:

1. In the Data Source Modeler, examine your data.

Measures are numeric values such as sales price, cost, and profit. Dimensions are the context that allow users to
understand the significance of the measures. For a sales database, the dimensions could include Product, Store,
Salesperson and so on. In other words, users can examine the sales figures by store, by product, and by sales.

Dimensions can have one or more hierarchies ( ). Hierarchies contain levels that organize data into a logical
structure. Click (+) next to fields under Measures and Hierarchies to display their contents. Moving up and down
between the levels of a hierarchy is called drilling.

Note:  Measures must originate in the fact table; for example, you cannot move numeric fields in a dimension
table under Measures or an error message is displayed. You cannot place two levels that originate in
different tables into a single hierarchy.

Unnecessary fields can be removed by clicking  (Delete) in the modeler toolbar.

You can move a field under Measures or Dimensions by clicking and dragging the field into its appropriate location.
A green check mark indicates that you can place your field without error.

Note:  Click  (Clear Model, in the upper right corner) to clear the existing model and start over.

Note:  If necessary, click  (Edit Source) in the modeler to make changes to database table selections and
joins, edit a SQL query, or CSV flat file Click Finish to save your updates. If you disable columns that were
previously enabled, a prompt appears in the modeler indicating that the data has been deleted. You must
adjust the data in the modeler before proceeding.

You can also move a field under Measures or Dimensions by clicking and dragging the field into its appropriate
location.

2. Click OK to update the data source.

The updated data source is now available to users.
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Editing a Database Connection in the Pentaho User Console

Follow the instructions below to edit a database connection in the Pentaho User Console:

1. In the New Data Source dialog box, under Connection, select the connection you want to edit.

2.
Click 
The Database Connection dialog box appears.

3. Update the connection information as needed. You can click Test to make sure your connection is working correctly.

4. Click OK to exit the Database Connection dialog box.

Deleting a Database Connection in the Pentaho User Console

Follow the instructions below to delete a database connection associated with the Pentaho User Console.

Important:  If you delete a database connection, all reports, charts, and other content users have created using
the connection will no longer render.

1. Under Connection in the New Data Source dialog box, select the connection you want to delete.

2.
Click  (Delete).
A warning dialog box appears.

3. Click OK to delete the connection.

Deleting a Data Source in the Pentaho User Console

If you have administrative permissions, you can delete data sources associated with ad hoc reports and dashboards in
the Pentaho User Console.

Important:  When you delete a data source all reports or charts that end-users have created based on that data
source will no longer render. Deleting a data source also deletes the model associated with that data source.

The delete Data Source option is available in the following instances:

•
When you select a data source and click  (Delete) when in the Select Data Source dialog box available from
File -> Manage -> Data Sources

• When you select a data source and click Delete in the Select Data Source step in Ad Hoc Reports
•

When you select a data source and click  (Delete) when creating a chart
•

When you select a data source and click  (Delete) when creating a data table

Adding Member Properties

Follow the instructions below to add member properties to a level. These member properties will appear when the
report is called into the dashboard.

Note:  This capability has always existed by editing the metadata, but now this capability exists within the Data
Source Modeler.

1. Within the Data Source Modeler, click on the Analysis tab.

2. Add member properties to the level you want to edit by dragging from the Available pane into the Analysis pane.
Alternatively, you can click the Add Member Property (green tag) icon.
The level contains the properties as you define them.

3. Select each of the geographical properties individually and assign a Geography Type within the Details Section of
the Properties Pane. This will classify the data with the correct geography type.
For geographical properties, the geography type is now defined.
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Auto Modeling Geography Dimension

You can use the auto populate function within the Data Source Model by clicking the Auto Populate button as shown in
the below image. This is best used for creating quick prototype models. When you use the auto populate function, the
Geography Type will also auto populate.

If you use the auto populate function, the geography dimension will also auto populate with the Geography Type for the
geographical properties.

Scheduling Reports
The Pentaho User Console has the ability to run reports at specified intervals, even if user input is required to properly
execute the report. The sections that follow explain how to set up and configure private schedules. Private schedules
are ad hoc, non-subscription schedules; subscription schedules, also referred to as public schedules are set up by an
administrator. You must have proper permissions to set up a private schedule.

For more information about schedules, see the demo, Scheduling, Subscription and Distribution, on the Pentaho Pre-
Sales Sandbox.

Scheduling a Report

You can configure the Pentaho BA Server to run reports at regular intervals, or on certain dates and times. Follow the
instructions below to create a private schedule.

1. In the Files pane on the left bottom of PUC's home page, navigate to the location of your report. It should appear in
the that list when you've selected the proper directory.

2. Right-click the report you want to schedule, then click Schedule in the context menu.

The New Schedule window appears.

3. Type in a name to identify the schedule by in the Name field, and a group name (for groups of schedules) in the
Group field. Optionally you can also enter a description of the schedule in the Description field.

4. Select an interval from the Recurrence drop-down box. If you would like to enter a custom interval, select Cron and
consult the Quartz reference to learn the Quartz syntax.

5. Adjust the interval settings accordingly; these settings should be self-explanatory.

6. Click OK to complete the schedule.

http://sandbox.pentaho.com/part-5-scheduling-subscription-and-distribution/
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The report is scheduled to execute at the interval you specified. It will also be listed in My Workspace.

Quartz Cron Attributes

The Quartz cron engine supports a seven-attribute time declaration with many possible values. The number format is
the same for every expression, even if the values are different -- it must be listed as seconds, minutes, hours, day of
month, month, day of week, then the year. A space separates each attribute.

Possible values for each attribute should be mostly obvious -- 0 to 59 for seconds and minutes, 0 to 23 for hours, 1
to 31 for days, 1 to 12 for months, 1 to 7 for day of week, and a four-digit year. Alternatively you can use three-letter
values for the day of week (MON, TUE, WED, THU, FRI, SAT, SUN), and three-letter values for the month (JAN, FEB,
MAR, APR, MAY, JUN, JUL, AUG, SEP, OCT, NOV, DEC).

An asterisk (*) indicates all values, so an asterisk in the minute field would mean that the report runs once every minute.
You can specify a range of values with the - (dash) operator, and you can specify multiple individual values with a
comma. If you need to excuse a value in the day of month and day of week field from a cron job, you can use the
question mark (?) character to indicate that this value doesn't matter. If you need to split values, you can do so with the
slash (/) character -- this operator literally means "every," so */15 would mean "Every 15." In the day of month field, you
can use the # character to indicate a certain instance of a day of the month, for instance the second Friday of the month
would be 6#2. Lastly, you can use a capital L in the day of month and day of week field to indicate "Last," as in the last
day of the week. A capital C in either of these fields means "Calendar," and combined with a number means that the
report should execute a the interval indicated by the C number according to the loaded calendar. A capital W in the day
of month attribute means "Weekday," which only encompasses Monday through Friday. Most of these values can be
combined to create unusual cron schedules.

Attribute Conditionals and Operators

Seconds , - * /

Minutes , - * /

Hours , - * /

Day of month , - * ? / L W C

Month , - * /

Day of week , - * ? / L C #

Year , - * /

Execute a report at 10:15 AM on every last Friday of every month during the years 2008, 2009,
2010, 2011 and 2012:

0 15 10 ? * 6L 2008-2012

Deactivating Schedules

Once you've scheduled a report, you can easily delete the schedule without deleting the report. You must have
administrative privileges to delete a schedule.

Note:  To reliably delete a schedule, suspend the schedule first then delete it from your workspace. After the
delete process completes, you may restart the schedule.

1. Click the My Workspace button, which is the second one in from the right side of the toolbar.

2. Click the triangle next to the Waiting section to see a list of scheduled reports.

3. Click Cancel next to the schedules you'd like to delete.

The previously scheduled report will no longer run at the specified interval.

Refreshing the Reporting Data Cache

By default, reports created with Report Designer and published to the BA Server will have their data sets cached to
improve performance. If you are working with a volatile data source and will be regenerating reports frequently, you
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may need to manually flush the report cache, which will force the Reporting engine to recalculate the result sets for all
reports.

To do this, log into the Pentaho User Console as an administrator user, then go to the Tools menu, select the Refresh
sub-menu, and click the Reporting Data Cache item.

Pentaho Interactive Report Settings
The settings.xml file for Pentaho Interactive Reporting located at,  \pentaho-solutions\system\pentaho-
interactive-reporting, can be edited to define page formats, to limit the number of results associated with the
filter search list, to set the browser cache, and to define page dimensions. Instructions are included in the file. Edit the
file as needed. The settings default values are shown in the sample below.

Note:  Always restart the Pentaho User Console after editing and saving the settings.xml file.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<settings>
    <!-- default template -->
    <default-template>1_jade_1_left_aligned.prpt</default-template>
    
    <!-- allowed page formats -->
    <!-- uncomment/edit to filter the list of page formats from the reporting engine
 -->
    <!-- <allowed-page-formats>A1,A2,A3,A4,A5,LEGAL,LETTER</allowed-page-formats> -->
     
    <!-- set this to true for production, and false for development/localization -->
    <cache-messages>true</cache-messages>
    
    <!--
         The maximum number of results to be loaded for the Filter search list for any
         given search string.
      -->
    <search-list-limit>500</search-list-limit>
    
    <!-- how far ahead to set the browser's cache -->
    <max-age>36000</max-age>
    
    <cache>true</cache>
    
    <!-- 
        The minimum allowable page dimension, in points (1/72 inches). This setting
 is 
        used to filter the list of page formats that the user can select from.
        The default is 3 inches.
        -->
    <minimum-page-dimension>216</minimum-page-dimension>
 
<plugin-id>pir_plugin_Release</plugin-id>
<plugin-version>TRUNK-SNAPSHOT</plugin-version>
<plugin-build>83</plugin-build>
</settings>

Troubleshooting
Below are problems that have been discovered by other Pentaho User Console users and testers, and solutions for
addressing them.

Internet Explorer 8 can't preview CSV/PDF/XLS ad hoc report content

Internet Explorer 8 has extra security features that prevent users from downloading content files generated by the ad
hoc reporting interface. In order to work around this, you must force IE8 to recognize the BA Server host as an intranet
zone.
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To do this, go to the Tools menu in Internet Explorer, then select Internet Options. In the ensuing options screen,
click the Security tab, then the Local Intranet icon. Click the Sites button. In the dialogue the follows, deselect the
Automatically detect intranet network option, then click OK to close this window, then OK again to close the Internet
Options window.

Dashboard Printing Not Working Consistently
If you are running on a Windows Operating System and Dashboard printing does not work all the time, there may be an
easy solution. You cannot consistently print dashboards if you are running the BA Server as a service. You must run the
BA Server as an application.

If Pentaho Business Analytics was installed using the graphical installer, the BA Server runs as a service. The BA
Server starts automatically, as a service, when you start the Windows machine. To ensure Dashboard printing always
works, you must start the BA Server as an application.

To see if the BA Server is running as a service, type Services into the Windows search menu. Open the Services
window and find Pentaho BA Server. If the server is started, click Stop to stop it.

To run the BA Server as an application, navigate to Program Files\pentaho\server\biserver-ee. Double-
click on start-pentaho.bat to start the BA Server. Running the BA Server this way ensures that Dashboard printing
works reliably.
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